	
	A


	 
	a, an, and the 
Include articles (a, an, and the) in lists and slides. Omitting articles and other words makes your sentences difficult to follow and presents problems for translation. 

Example:
Expand the html folder to see the folder contents. 
   not
Expand html folder to see folder contents.


	 
	abbreviations and acronyms 
(See also Latin words and abbreviations)
All acronyms are abbreviations, but not all abbreviations are acronyms. An abbreviation is a shortened form of a word. An acronym is an abbreviation formed from the first letter of each word in a phrase. An acronym is often pronounceable as a word. For print publications, spell out acronyms at their first occurrence in each lesson, and use the shortened form in subsequent occurrences. For Web content, it may be necessary to define acronyms more frequently because students can navigate through multiple Web pages in a nonlinear manner.

Guidelines
Do not abbreviate terms such as the following, except possibly in tables and graphics where space is an issue: 

Use
Do Not Use
application

app

company

co.

demonstration

demo

information

info

number

no. or num.

quantity

qty

Reserve abbreviations for established abbreviated terms such as units of measurement. 
Term
Abbreviation
gigabyte

GB

kilobit

Kb

kilobyte

KB

megabit

Mb

megabyte

MB

Place the spelled-out version of the abbreviation or acronym before the initials at its first occurrence in each lesson, not the other way around, even with familiar terms. 
Example:
Use an entity relationship model (ERM) to map entities in your database.
   not
Use an ERM (entity relationship model) to map entities in your database. 

Use the correct indefinite article before an abbreviation or acronym, depending on the sound of the first letter or the pronounceable word. If it is a vowel sound, use an; if it is a consonant sound, use a.

Examples:
The data is stored in an LRU table. (pronounced “ell-are-you”)
To access the site, you need a URL. (pronounced “you-are-ell”)
Oracle offers a SQL course in its training curriculum. (pronounced “sequel”)

Add a lowercase s to the letters of an abbreviation or acronym to form the plural, except when it includes internal periods. In such cases, add an apostrophe and s.

Examples:
There are three DBAs in the data center.
John has two Ph.D.’s.

Do not automatically capitalize abbreviations and acronyms when spelling them out. Follow the style of the specific term. For example, SQL is spelled out as “structured query language” and HTML is spelled out as “Hypertext Markup Language.” 

Do not automatically add periods when abbreviating a term.

Example:
the Oracle University Style Guide (OUSG)
not
the Oracle University Style Guide (O.U.S.G.)


	 
	List of abbreviations and acronyms 

Note: The terms with asterisks (*) do not need to be spelled out.

Abbreviation or Acronym

Term
ACID

atomicity, consistency, isolation, durability

ACL

access control list

A.D.*

anno Domini (in the year of the Lord)

ADA

Americans with Disabilities Act

ADC

analog-to-digital converter

ADF

Application Development Framework

ADK

application development kit

ADL

Advanced Distance Learning

ADP

automatic data processing

AI

artificial intelligence

AIM

Application Implementation Method

a.m.*

ante meridiem (before noon)

ANSI

American National Standards Institute

AOL

Application Object Library

AP

accounts payable

API*

application programming interface

AR

accounts receivable

ASCII*

American Standard Code for Information Interchange 

ATM

asynchronous transfer mode

ATO

assemble-to-order

ATP

available-to-promise

AWT

Abstract Window Toolkit

B2B

business-to-business

B2C

business-to-customer, business-to-consumer

bash

Bourne-again shell

BASIC*

Beginners All-Purpose Symbolic Instruction Code 

BBS

bulletin board system

B.C.*

before Christ

BFILE

binary large file object

BI

business intelligence

BIFF

binary interchange file format

BIOS

basic input/output system

BIS

business information systems

BLOB

binary large object

BNF

Backus-Naur form

BOM

Bills of Material; bill of material (generic)

BPO

blanket purchase order

BPR

Business Process Reengineering

BSD

Berkeley Software Distribution

Btu*

British thermal unit

CAD

computer-aided design

CAE

computer-aided engineering

CAI

computer-aided instruction

CAL

computer-aided learning

CAM

computer-aided manufacturing

CASE

computer-aided systems engineering

CAT

computer-aided testing; computer-assisted teaching

CBL

computer-based learning

CBO

cost-based optimizer

CBT

computer-based training

CCID

code combination identification

CD

compact disc

CDI

Customer Data Integration

CD-ROM*

compact disc read-only memory

CGA

color graphics adapter

CGI

computer graphics interface; common gateway interface 

CGM

computer graphics metafile

CIP

construction-in-process

CIS

computer information systems

CISC

complex instruction set computer (or computing) 

CLOB

character large object

CMP

container-managed persistence

COBOL*

Common Business-Oriented Language

COBRA

Consolidated Omnibus Budget Reconciliation Act 

COGS

cost of goods sold

COR

complex object retrieval

CORBA

Common Object Request Broker Architecture

CPU*

central processing unit

CSR

customer service representative

CSS

cascading style sheet; Cascading Style Sheets (the mechanism)

CTI

computer-telephone integration; computer-telephony integration

CTS

Compatibility Test Suite

DASD

direct access storage device

DAT

digital audio tape

DB

database

DBA*

database administrator

DBCS

double-byte character set

DBMS

database management system

DBWn
Database Writer (note the lowercase italic n)

DCE

distributed computing environment

DCL

data control language

DCN

domain configuration node

DDBMS

distributed database management system

DDE

dynamic data exchange

DDL

data definition language

DES

data encryption standard

DHCP

dynamic host configuration protocol

DIF

data interchange format

DLL

dynamic-link library

DLM

Distributed Lock Manager

DM4J

Data Mining for Java

DMA

direct memory access

DML

data manipulation language

DNS

domain name server

DOM

Document Object Model

DOS

disk operating system

dpi

dots per inch

DRAM

dynamic RAM; dynamic random access memory

DRL

data retrieval language

DSS

decision support system

DTD

document type definition

DTP

desktop publishing

EBCDIC

Extended Binary Coded Decimal Interchange Code 

EAR

Enterprise Archive

e-business*

electronic business

E-Business Suite*

Electronic Business Suite (a product name)

e-commerce*

electronic commerce

ECO

engineering change order

EDI

electronic data interchange

e-form

electronic form

EFT

electronic funds transfer

EGA

enhanced graphics adapter

EIS

Enterprise Information System

EM

Enterprise Manager

e-mail*

electronic mail

EMEA

Europe, Middle East, and Africa

EMU

European Economic and Monetary Union

EOUG

European Oracle Users Group

EP

enterprise portal

EPROM

erasable programmable read-only memory

EPS

encapsulated PostScript

ER

entity relationship

ERD

entity relationship diagram; Entity Relationship Diagrammer 

ERM

entity relationship model

ERP

enterprise resource planning

ETL

extract, transform, load

EUL

End User Layer

FAT

file allocation table

fax*

facsimile; not FAX
FCB

file control block

FCC

Federal Communications Commission

FHD

Function Hierarchy Diagrammer

FIFO

first in, first out

FLOP

floating-point operation

FLOPS

floating-point operations per second

FORTRAN*

Formula Translation

FSF

Free Software Foundation

FSG

Financial Statement Generator

FTP*

File Transfer Protocol

GB*

gigabyte

GDI

graphics device interface

GEMMS

Global Enterprise Manufacturing Management System 

GIF

graphics interchange format

GIMP

GNU Image Manipulation Project

GL

General Ledger (Oracle product name)

GNOME

GNU Network Object Model Environment

GNU

GNU's not UNIX

GPF

general protection fault

GPI

graphics programming interface

GPL

General Public License

GTK

GIMP Toolkit

GUI

graphical user interface

GUID

globally unique identifier

HDBMS

hierarchical database management system

HDLC

high-level data link control

HDTV

high-definition television

HR

human resources; Human Resources (Oracle product name)

HRMS

Human Resources Management System (Oracle product name)

HS

Heterogeneous Services

HTML*

Hypertext Markup Language

HTTP*

Hypertext Transfer Protocol

Hz*

hertz

I-CASE

Integrated Computer-Aided Software Engineering

ICX

intercartridge exchange

ID*

identification; not Id or id
IDE

integrated development environment

IEEE

Institute of Electrical and Electronics Engineers 

IIOP

Internet Inter-ORB Protocol

ILT

instructor-led training

IMAP*

Internet Message Access Protocol

I/O

input/output

IOT

index-organized table

IOUG

International Oracle Users Group

IP*

Internet Protocol

IS

information systems

ISDN*

integrated service digital network

ISO

International Organization for Standardization

ISO/OSI

International Organization for Standardization/Open Systems Interconnection

IT

information technology

ITV

interactive TV

J2EE

Java 2, Enterprise Edition

J2ME

Java 2, Micro Edition

J2SE

Java 2, Standard Edition

JAAS

Java Authentication and Authorization Service

JAE

Java Application Environment

JAIN

Java APIs for Integrated Networks

JAR

Java Archive

JAXB

Java Architecture for XML Binding

JAXM

Java API for XML Messaging

JAXP

Java API for XML Processing

JAXR

Java API for XML Registries

JAZN

Java Authorization

JBCL

JavaBeans Components Library

JCA

J2EE Connector Architecture

JCP

Java Community Process

JDAPI

Java Design-Time API

JDBC

Java Database Connectivity

JDK

Java Development (or Developer's) Kit 

JFC

Java Foundation Classes

JIT

just-in-time

JMS

Java Message Service

JNDI

Java Naming and Directory Interface

JPEG

Joint Photographic Experts Group

JRE

Java Runtime Environment

JSP

JavaServer Pages (API and technology; JSP may refer to a singular JavaServer Page, JSPs refers to multiple JavaServer Pages)

JSR

Java Specification Request

JSSE

Java Secure Socket Extension

JTA

Java Transaction API

JTS

Java Transaction Service

KDE

K(ommon) Desktop Environment

JVM

Java Virtual Machine

Kb*

kilobit

KB*

kilobyte

Kbps

kilobits per second

kc

kilocycle

kHz*

kilohertz

kV*

kilovolt

kW*

kilowatt

LAN

local area network

LCD

liquid crystal display

LDAP

Lightweight Directory Access Protocol

LED

light-emitting diode

LGWR

LogWriter

LIFO

last in, first out

LOB

large object

LOV

list of values

LRPC

lightweight remote procedure call

LRU

least recently used

LSB

least significant bit

LSC

least significant character

LSI

large-scale integration

MAPI

messaging application programming interface

Mb*

megabit

MB*

megabyte

MBT

media-based training

Mc

megacycle

MCGA

multiple-color graphics array

MDI

multiple-document interface; medium dependent interface 

MDS

master demand schedule

MES

Marketing Encyclopedia System

MHz*

megahertz

MIDI

musical instrument digital interface

MIME

Multipurpose Internet Mail Extensions

MIPS

millions of instructions per second

MIS

management information systems

MMU

memory management unit

MOM

message-oriented middleware

MPP

massively parallel processing

MPS

master production schedule

MRC

Multiple Reporting Currencies

MRP 

material requirements planning

ms* or msec

millisecond

MTS

multithreaded server

mV

millivolt

MVC

Model View Controller

N/A

not applicable; not available 

NC

network computer

NCA

Network Computing Architecture (is now Internet computing)

NCLOB

multibyte character large object

NCOS

network computer operating system

NDK

network development kit

NetBEUI

NetBIOS extended user interface

NetBIOS

network basic input/output system

NFS

network file system

NLS

national language support

NOS

network operating system

NUMA

nonuniform memory access

OC4J

Oracle 9iAS Containers for J2EE

OCI

Oracle Call Interface

OCO

Oracle ConText Option

OCP

Oracle Certified Professional

OCX

OLE custom control

ODBC

Open Database Connectivity

ODL

Object Description Language

OEM

original equipment manufacturer; Oracle Enterprise Manager

OEO

Oracle Express Objects

OFA

Oracle Financial Analyzer

OIS

office information systems

OLA

Online Learning Architecture

OLAP

online analytical processing

OLE

object linking and embedding

OLTP

online transaction processing

OMG

Object Management Group

OOFS

object-oriented file system

OOW

Oracle OpenWorld

OPI

Oracle Program Interface

ORB

object request broker

ORDBMS

object relational database management system 

ORPC

object remote procedure call

OS

operating system; not O/S
OTM

Oracle Telephony Manager

OTS

Object Transaction Service

OTT

Object Type Translator

PCM

parallel cache management

PDA

Personal Digital Assistant

PDF*

portable document format

PDK

Portal Development Kit

PDML

parallel data manipulation language

PERL*

Practical Extraction and Report Language

PERT

program evaluation and review technique

PFF

printer file format

PFILE

parameter file 

PGA

Program Global Area

PID

processor identifier

PIN

personal identification number (do not use PIN number)

PL/SQL*

Oracle's Procedural Language extension to SQL

p.m.*

post meridiem (after noon)

POA

Portable Object Adapter

PPP

Point-to-Point Protocol

PPV

purchase price variance

PR

purchase requisition

PROM

programmable read-only memory

QA

quality assurance

QBE

query by example

RAC

Real Application Clusters; pronounced "rack," not are-ay-see
RAID

retrieval and information database; redundant array of independent disks

RAM*

random access memory

RAR

Remote Archive

RCO

reusable content object

Rdb7

Oracle Rdb version 7

RDBMS*

relational database management system

RFQ

request for quotation

RGB

red-green-blue

RIFF

resource interchange file format

RISC

reduced instruction set computer (or computing) 

RMA

return material authorization

RMAN

Recovery Manager

RMI

Remote Method Invocation

ROM*

read-only memory

ROM BIOS

read-only memory basic input/output system

RPC

remote procedure call

RPM

Red Hat Package Manager

RTF

rich text format

SAX

Simple API for XML

SBCS

single-byte character set

SBU

strategic business unit

SCN

system configuration node

SCSI*

small computer system interface

SDI

single-document interface

SDK

software development (or developer's) kit 

SDLC

synchronous data link control; system development life cycle 

SGA

System Global Area

SGML

Standard Generalized Markup Language

SI

systems integration

SID

system identifier

SLIP

Serial Line Internet Protocol

SME

subject matter expert

SMP

symmetric multiprocessing

SMTP

Simple Mail Transfer Protocol

SNA

systems network architecture

SNMP

Simple Network Management Protocol

SNS

secure network services

SOAP

Simple Object Access Protocol

SOB

set (sets) of books; use if necessary only on slides, not in text

SPFILE

server (-side) parameter file

SPI

service provider interface

SPOC

single point of contact

SQL*

structured query language

SQLJ

SQL for Java

SSL

secure sockets layer

SVGA

super video graphics adapter

TB

terabyte

TCP*

Transmission Control Protocol

TCP/IP*

Transmission Control Protocol/Internet Protocol 

TIFF

tag image file format

TPS

Technical Publications Services; technical publications specialist 

TSR

terminate-and-stay-resident

UDT

user-defined type

UID

unique identifier

UIX

user interface XML

UOM

unit of measurement

UPC

universal product code

URI

Uniform Resource Identifier

URL*

Uniform Resource Locator

UTC

Universal Time Coordinate

UUID

universally unique identifier

VAR

value-added reseller

VARRAY

varying-length array

VAT

value-added tax

VGA

video graphics adapter

VIO

video input/output

VLDB

very large database

VLSI

very large-scale integration

VM

virtual memory

VRML

Virtual Reality Markup Language

VSAM

virtual storage access method (or memory)

W3C

World Wide Web Consortium

WAIS

wide area information servers

WAN

wide area network

WAR

Web Archive

WBS

work breakdown structure

WBT

Web-based training

WIP

Oracle Work in Process

WORA

write once, run anywhere

WORM

write once, read many

WRB

Web request broker

WRBX

Web request broker executable engine

WWS

Oracle Worldwide Support

WWW

World Wide Web (the Web is preferred)

WYSIWYG

what you see is what you get

XML

Extensible Markup Language

XSL

Extensible Style Sheet Language

YTD

year to date




	 
	about, of, and on
Do not use on or of when you mean about.

Examples:
See the installation guide for further details about the installation types
   not
See the installation guide for further details of the installation types.

This lesson contains information about setting up Oracle Real Application Clusters.
   not
This lesson contains information on setting up Oracle Real Application Clusters.

above and below
(See also cross-references; release and version)
Whenever possible, do not use spatial terminology in cross-references.

Do not use above and below to refer to other sections of text within a lesson or course. Identify the area that you are referencing by using its title. 
Examples:
See the preceding slide on data warehousing. 
   not
See the section above. 

For more information, see the following page. 
   not
For more information, see below.

When necessary, use above to refer to a slide, diagram, or table that appears above the text on the same page.

When necessary, use the following to refer to a diagram or table that appears below the text on the same page.

	 
	 


	 
	acronyms 
(See abbreviations and acronyms)


	 
	active and passive verbs 
(See verbs: Active Verbs)


	 
	affect and effect
Distinguish between affect and effect.
Affect (verb) means to influence.
Example:
The parameter settings affect performance. 

Effect (noun) means result.
Example:
The effect of this command is powerful.

Effect (verb) means to bring about. 

Example:
This command could effect changes to the environment.


	 
	allow, enable, let, and help
(See also personification)
One instructional design guideline for Oracle University materials is to focus on the user. One way to do this is to structure sentences so that the user is the active party. 
When possible, avoid using allow, enable, let, or help by restructuring the sentence. Make the user the subject of the sentence and choose a verb that describes the action the user performs.
Examples:
When you use templates and catalogs, you can concentrate on writing documentation, rather than formatting it.
  not
Using templates and catalogs allows you to concentrate on writing documentation, rather than formatting it.

Using the graphical approach to database design, you can grasp complex interdependencies.
   not
The graphical approach to database design enables you to grasp complex interdependencies.

You format your report by using the Layout Editor.
   not
The Layout Editor helps you format your report.

If you want to focus on the product or feature you are describing rather than the user, use the verb enable to suggest ability. Do not use the verb allow to suggest ability.

Example:
The Multicurrency feature enables users to prepare invoices in the native currency of their clients.
  not
The Multicurrency feature allows users to prepare invoices in the native currency of their clients.

Use the verb allow only when discussing permissions or privileges.

Example:
When the administrator grants you the status of participant, you are allowed to access the files.


	 
	alternately and alternatively
Alternately implies one after the other, and alternatively implies one or the other. 
Example:
Alternatively, you can enter account balances into OPM manually.
   not
Alternately, you can enter account balances into OPM manually.


	 
	American and British usage 
Oracle University courses should be written in American English. When there is a difference between British and American usage, follow these guidelines. (See terminology for a list of preferred terms.) When possible, use generic terminology that speakers of both American and British English can understand.
Note: In courses intended exclusively for British or British English–speaking audiences, British spelling and terminology may be most appropriate in some contexts. For example, if product names and application functionalities use British spellings for particular terms, make sure the terms appear consistently with British spellings throughout the course. 

Example:
The ChequeWriter generates cheques before you run the prepayment process.
  not
The ChequeWriter generates checks before you run the prepayment process.

Use -ize for word endings that are spelled -ise in British English (recognise) and -ize in American English (recognize).

Notice, however, that some words are spelled -ise in both British and American English.

Examples:
advertise 
enterprise 
supervise 
compromise 

Use -or for words that end in -our in British English (colour) and -or in American English (color). 

In American English, if the last syllable of a word is not stressed in pronunciation (cancel, label, model, travel), do not double the final consonant before adding suffixes that begin with vowels, such as -ed and -ing (canceled, labeling, modeled, traveling). If the last syllable of the word is stressed (begin, control, dispel, remit), double the consonant before adding these suffixes (beginning, controlled, dispelling, remitted).

Do not use should to introduce a conditional statement when you mean if. 

Example:
If you need additional menu functions, you can create a custom menu.
  not
Should you need additional menu functions, you can create a custom menu.

Use double quotation marks (American standard) instead of single quotation marks (British standard) to set off phrases and quoted speech.

Place commas and periods inside of quotation marks (American standard).

If you use a word with more than one accepted spelling, use the spelling listed first in Merriam-Webster’s Collegiate Dictionary, 11th ed.


	 
	angle brackets
(See also brackets)
If a user must enter two or more variables in a row, set the variables in italic and separate them with angle brackets (< >). Otherwise, indicate variables by using italic without angle brackets.

Examples:
Log on as <username><password>. Rename the practice by entering your <last name><practice number>.
Enter user_us@oracle.com, where user_us is the name of the user.

Do not refer to angle brackets as "carets" or "arrows."


	 
	apostrophes
(See also contractions)
Use an apostrophe to denote possession in nouns. 
Examples:
Consider the user’s needs when you develop a course.
The company’s employees received bonuses each year. 

Do not use product names in possessive form. 

Example:
Oracle Files Online capabilities
   not
Oracle Files Online's capabilities 

You can use the possessive with the company name. 

Example:
Oracle’s fourth-quarter earnings were very strong.

Do not use an apostrophe in the possessive of the pronoun it. 

Example:
This chapter is divided into subsections. Its main subsections appear in bold type. 
   not
This chapter is divided into subsections. It’s main subsections appear in bold type. 


	 
	as, because, and since 
Do not use as or since when you mean because. Use because to mean “for the reason that” and since to mean “from a time in the past.” These terms can sometimes be used synonymously, but distinguishing between them enhances clarity and aids translation.
Example:
Because only those objects that have changed since the last export are backed up, this feature reduces the export time.


	 
	assure, ensure, insure
Use assure to mean "make certain" in reference to people. Use ensure to mean "make certain" in all other references besides people. Use insure to mean "contract to provide insurance."

Examples:
The company assures its customers that it stands behind the product. 
To ensure compliance, it is important to notify everyone of the new regulations. 
It is a good idea to insure your home if you own a computer. 


	 
	B 


	 
	Backus-Naur form
Backus-Naur form (BNF) is a specific type of notation, as well as a metalanguage that is used for defining the syntax of formal languages. The typographic conventions for BNF are distinctive and differ in several ways from those currently described in the OUSG typographic conventions table.
As shown in the following example, BNF syntax uses bold font, brackets, braces (curly brackets), and vertical bars. Regular font, rather than italic, is used to indicate placeholders.

ALTER INDEXTYPE [ schema. ]indextype
  { { ADD | DROP }
 [ schema. ]operator (parameter_types)
  [, { ADD | DROP }
 [ schema. ]operator (parameter_types)
  ]...
 [ using_type_clause ]
| COMPILE
} ;
For additional information about the available BNF syntax, visit the following Web site: 

http://www-st.us.oracle.com/obj_db_prod/
sql_language/sqlbnf/grammar.html 


	 
	because
(See as, because, and since)


	 
	because of and due to
(See also as, because, and since) 
Do not begin a sentence with due to, but you can begin a sentence with because of. Use due to as an adjective phrase. It follows a form of the verb to be such as is. Use because of as a preposition. 
Examples:
Because of a power outage, the systems went down. The failure of the systems is due to a power outage.


	 
	below 
(See above and below; release and version)


	 
	bibliographies
Consult a reference book, such as Chicago Manual of Style or Words into Type, for examples of bibliographic entries. 


	 
	bold type
(See also emphasis)
In print documents, do not use bold for emphasis; use italic, sparingly. Bold type is used as a formatting style, generally in headings and subheadings, and for terms such as Note and Caution. To ensure that the style is correct, use the current template. 

In online material, use bold for emphasis, sparingly. Always put the following punctuation marks in bold when they immediately follow words in bold: periods, commas, colons, semicolons, and question marks.


	 
	brackets
(See also angle brackets)
Use brackets ([ ]) inside parentheses in sentences. Do not call them square brackets. 
Use brackets to enclose names of keys. 

Examples:
Press and hold [Ctrl] + [Alt] + [Delete]. 
Press and release in succession [Alt], [F], [D]. 
Press [Enter]. 


	 
	bulleted lists
(See lists) 


	 
	by 
When the subject of an action does not immediately precede a concluding verb phrase, use the preposition by to clarify who or what performs the action.

Example:
In this lesson, you will learn how to query a database by using SQL.
   not
In this lesson, you will learn how to query a database using SQL.

Note: By is necessary here to clarify that the student, rather than the database, is using SQL. 


	 
	C 


	 
	callouts
(See graphics labels)


	 
	can and may 
(See also may and might)
Can implies capability. May implies possibility or permission. Do not use the word may to mean permission granted by the system or by an application. 
Example of capability:
You can customize Oracle Housing to reflect the policies and procedures of your organization. 
   not
You may customize Oracle Housing to reflect the policies and procedures of your organization. 

Example of possibility:
If your rollback segments are too small, you may lose data. 
   not
If your rollback segments are too small, you can lose data.


	 
	capitalization
The following table defines capitalization terms:
Term
Definition
Caps/lowercase (clc)

The first letter of all significant words in a title, phrase, or single word is capitalized.

Initial (init) cap

The first letter of only the first word in a title or phrase is capitalized.

Uppercase (uc)

Every letter in a word or phrase is capitalized.

Lowercase (lc)

None of the letters in a word or phrase are capitalized.

Small caps (sc)

Every letter in a word or phrase is set in small capitals. 

General Guidelines
Use the general guidelines provided here, in addition to those in the following sections, to determine when to capitalize:
Keep the capitalization of specific terms consistent throughout text. That is, do not put the first occurrence of the term in initial or all caps and later present it in all lowercase letters. 

Do not use caps/lowercase unless the term is a proper name. 

As a general rule, present terms in the capping style shown in the user interface. If the interface presents an inconsistent or grammatically incorrect style, follow the guidelines in this section. 

Remember that not all abbreviations and acronyms are automatically spelled out in caps/lowercase. Follow the style of the specific term. For example, SQL is spelled out as “structured query language” and HTML is spelled out as “Hypertext Markup Language.” (See also abbreviations and acronyms) 

Capitalization in Titles:
What to Capitalize
Capitalize the significant words (nouns, pronouns, adjectives, adverbs, subordinate conjunctions, and first and last words) in titles and headings. 

Examples:
Hierarchical Structure of a Menu 
When a Menu Is a Default Menu 
About Names and Labels 
Learning While You Sleep 

Note: Capitalize all verbs in all titles and headings, including is and are.
Capitalize adverbs in titles and headings. 

Examples:
Logging In (or On)
Logging Out (or Off) 
Setting Up Your Computer 

In a title or heading, capitalize prepositions of five or more letters. Capitalize prepositions of four or fewer letters only when they appear as the first or last word of the title or heading.

Examples:
About Your New Computer
Working Without an Editor 
Tasks to Perform After Setup 
Checking Data Against Archived Records
Resources to Call Upon
Generally, capitalize the second element of a compound word. 

Examples:
Task-Oriented Objectives 
Text-Entry Screens 

Note: Do not capitalize the second element of a compound numeral, and do not capitalize the second element of a permanent compound such as built-in, unless the compound appears at the end of the title.

Examples of exceptions:
One-fifth Disk Space Usage 
About Built-in Modems 
Modems: External and Built-In 

Capitalization in Titles:
What Not to Capitalize
Do not capitalize prepositions with fewer than five letters, unless they appear at the beginning or end of a title or heading. 

Examples:
Data Types Supported by Oracle9i 
Limitations of Stored Procedures
Learning About Your New Computer 
Working with an Editor 
What to Look For
Do not capitalize the word to in an infinitive phrase in a title. 

Examples:
Fields to Be Completed 
When Not to Use the Colon 

Do not capitalize articles and coordinate conjunctions in a title unless they occur at the beginning of the title. 

Examples:
The Hierarchical Structure of a Menu
Collapsing and Expanding Menus 

Capitalization in Text:
What to Capitalize
Capitalize the names of specific segments of courses. 

Examples:
Unit II, Lesson 4, Appendix A 
(but lowercase this unit, the lesson, an appendix) 

Capitalize the first word in list items. 

Example:
You can use the following methods to store dimensional data:
   • Standard RDBMS
   • Standard GIS architectures
   • Hybrid GIS architectures 

Capitalize the first word in graphics labels. 

Examples:
Menu bar 
Set of books 

Capitalize the first word that follows a colon in text if that word begins a full sentence. Lowercase the word if it begins a fragment. 

Example of full sentence:
Remember this rule: Use a comma before the conjunction in a series.

Example of fragment:
The number of options in a menu depends on two factors: the number of lines that the screen can hold and the length of the menu titles. 

Capitalization in Text:
What Not to Capitalize
Do not capitalize a job title unless it is a formal role or function in an application. 

Examples:
course developer 
curriculum manager 
system administrator 
the System Administrator role 

Do not capitalize words such as step and page in text when they come before numbers.

Examples:
Go to step 6. 
See page 3-10.

Do not capitalize a term that is abbreviated or made into an acronym if the term is not an established proper name. (See also abbreviations and acronyms) 

Examples:
You should include an entity relationship diagram (ERD). 
Using the Oracle Call Interface (OCI), you can do the following: 

Do not capitalize a category name in its plural form. (See also category names)

Examples:
The Error Report and the Debug Report 
   becomes
The Error and Debug reports 

The Answer Wizard and the Layout Wizard 
   becomes
The Answer and Layout wizards 

Capitalization of Interface Elements 

Capitalize terms such as the names of buttons, fields, windows, and other interface elements. (See GUI conventions and typographic conventions for more extensive lists.)

Use the following conventions for the capitalization of interface elements:

Term

Example

buttons

Cancel button

check boxes

Freeze check box

events

Validate the Item

fields

Account Name field

forms

Purchase Requistion form

menus

Print menu

menu commands

Paste command

modes

Query mode

property groups

Menu Module property; Item property

regions

Contact region

settings

Deferred with Auto-Query; Immediate

windows

Suspend Party by Report Center window

wizards

Layout Wizard; Layout and Report wizards

Note: Follow the capitalization used in the interface, unless the interface is inconsistent. If the interface is inconsistent and you are in a position to offer comments, request that it be corrected to one consistent style. Otherwise, follow the guidelines in this section.


	 
	category names 
In phrasing terms that belong to categories or classes (files, statements, modules, parameters, reports, and so on), place the object name before its category name. 
Example:
the init.ora file 
   not
the file init.ora 
Do not capitalize the category name in the plural form, even if the object name and category name are capitalized in the singular form.

Example:
The Layout Editor and the Style Editor
  becomes
The Layout and Style editors


	 
	cautions 
(See also notes; warnings)
Use caution notices to inform users that failure to take or avoid a specified action could result in loss of data. 

Put all information under one notice. Do not repeat the caution heading.

Follow the word Caution with a colon, and put the word and the colon in bold. 

Example:
Caution: Failure to save your work will result in loss of data. 


	 
	click and double-click 
(See also GUI conventions)
Use click or double-click with terms such as interface buttons and icons. Do not use click on or double-click on. You can, however, click in a field or an area on the screen. 
Examples:
To send e-mail, click Send. 
To start Forms, double-click the Oracle program icon. 
Click in the Organization field.


	 
	code 
(See also typographic conventions)
Use Courier New (Courier New) font for all code text. 
Do not put syntax variables in angle brackets (<>) except when needed to set off multiple variables. (See also angle brackets). Use Courier New, italic. 

Example:
CREATE ROLE role
   not
CREATE ROLE <role>


	 
	colons
(See also lists)
Use a colon after the introduction to a list, whether the introduction is a full sentence or a fragment. 
Example of full-sentence introduction: 
The number of options in a single menu depends on the following factors:
   • The number of lines that the screen can hold 
   • The length of the menu titles 

Example of sentence-fragment introduction: 
The number of options in a single menu depends on: 
   • The number of lines that the screen can hold 
   • The length of the menu titles 

Do not use a colon to introduce a heading.

Example:
Some parts of a title do not need to be capitalized.

In text, do not use a colon to introduce a list that follows grammatically from the sentence introduction.

Example:
The number of options in a single menu depends on the number of lines that the screen can hold and the length of the menu titles. 
   not
The number of options in a single menu depends on: the number of lines that the screen can hold and the length of the menu titles. 

Do not use a colon in text as a separator in the way that you use a semicolon, dash, or comma. 

Use a colon to separate parts of a title or heading. 

Examples:
Step 1: Connecting to the Database
   not
Step 1 - Connecting to the Database

Data Compression Optimization: Enabling Row Movement
   not
Data Compression Optimization - Enabling Row Movement

Do not add a space before a colon.


	 
	commas
Use a comma before the conjunction in a series of three or more items for clarity and consistency. (This is sometimes called the serial comma or series comma.) 
Examples:
The box contains forms that are white, blue, yellow, and pink. (This example clearly indicates forms of four different colors.)
not 
The box contains forms that are white, blue, yellow and pink. (Without the serial comma, this might be misconstrued as only three types of colored form: a white one, a blue one, and a yellow and pink one.)

Do not capitalize job titles such as course developer, curriculum manager, and system administrator.
   not
Do not capitalize job titles such as course developer, curriculum manager and system administrator.

Use a comma after an introductory clause. Such clauses frequently begin with words such as after, during, if, and when. Using a comma aids in readability and avoids ambiguity. 

Example:
If you enter an application status incorrectly, you can correct it only by deleting the record and replacing it with a new record. 
   not
If you enter an application status incorrectly you can correct it only by deleting the record and replacing it with a new record. 

Use a comma after an introductory infinitive phrase.

Example:
To add a row to a table, use the INSERT statement.
   not 
To add a row to a table use the INSERT statement.

Do not use a comma to separate two verbs that have the same subject. 

Example:
The price of stock rose slightly and then declined.
   not
The price of stock rose slightly, and then declined. 


	 
	compare to and compare with
Use “compare . . . to” to show similarity between things of a different order. 
Example:
You can compare a computer monitor to a television console. 

Use “compare . . . with” to show differences between things of the same order. 

Example:
When you compare a UNIX operating system with a DOS system, you find that the UNIX system offers more power. 


	 
	compose and comprise
These words are not interchangeable. The whole comprises the parts and the parts compose (or make up) the whole. 
Examples:
The class comprises students and observers. 
Students and observers compose the class. 
The class is composed of students and observers. 

Note: Do not use is comprised of. 


	 
	compound words and hyphens 
(See also dashes; prefixes; suffixes)
Because there are many compound words in both noun and adjective forms for which no authoritative spelling can be found, consider some general definitions and principles.
Definitions 

Adjectival compounds, also called compound adjectives or compound modifiers, are usually hyphenated unless there is little or no risk of ambiguity. 
Examples:
all-inclusive study
high-level management 
interest-bearing loan 
spelled-out acronym 
tool-specific procedure 
well-known fact 

An open compound is a combination of separate words that constitute a single concept. Open compounds are not hyphenated.

Examples:
laser printer 
life cycle 
lowest common denominator
personal computer 
vice president 

A hyphenated compound is a combination of words joined by one or more hyphens. 

Examples:
kilowatt-hour
light-year 
trade-off

A closed (or solid) compound is a combination of two or more elements spelled as one word.

Examples:
bitmap 
database 
file name 
toolbar 

A permanent compound is one that has been accepted into the general vocabulary and can be found in dictionaries. A permanent compound can be open, hyphenated, or closed. 

Examples:
personal computer 
vice president 
built-in 
up-to-date 
database 
workforce 

A temporary compound is a joining of words for some specific purpose. 

Examples:
equijoin 
flexfield 
tablespace
toolbar 

If a temporary compound becomes commonly used, it can acquire the status of a permanent compound and as a result appear in dictionaries. 

Guidelines 
Use a hyphen (-) to join compound words and some prefixes. Note that the hyphen is shorter than either an en dash (–) or an em dash (—). 

Examples:
cross-reference
non-English speaker

When a temporary compound is used as an adjective before a noun, it is often hyphenated to avoid ambiguity. 

Examples:
end-of-text string 
tool-specific instructions 

When a phrase offers little or no risk of ambiguity, omit the hyphen.

Examples:
local area network 
word processing application 
operating system specific 

Note: Do not hyphenate the unit operating system, even when it is an adjective or part of a compound adjective, as in operating system–specific guidelines. (The correct separating punctuation in this instance is an en dash rather than a hyphen.) 

Do not use the hyphen when a compound word follows the noun that it modifies (called a predicate adjective). 

Examples:
This search method is tool specific.
   not
This search method is tool-specific. 
Use hyphens with the prefixes cross-, self-, and half- regardless of whether the words that contain these prefixes precede or follow the nouns that they modify. 

Examples:
a cross-trained employee 
The employee is cross-trained.

a self-run program 
The program is self-run. 

half-intensity power 
The level of power is at half-intensity. 

Use a hyphen to connect a cardinal or ordinal number with a word to modify a noun. 

Examples:
16-bit register 
fourth-generation language 

Do not use a hyphen after an adverb that ends in -ly when that adverb is part of a compound modifier. You must, however, distinguish between adverbs that end in -ly and adjectives that end in -ly. 

Examples:
newly purchased network computers (adverb-adjective) 
scholarly-looking developer (adjective-adjective) 
early-afternoon meeting (adjective-noun) 

Do not use a hyphen to separate a word from its definition or explanation.

Examples:
Username: sarah.jones
   not
Username - sarah.jones

CPU: The main processing component of a computer that reads from and writes to a computer's memory 
   not
CPU - The main processing component of a computer that reads from and writes to a computer's memory

Do not use long noun strings as modifiers. 

Example:
This equipment terminates a data circuit. 
   not
This is data circuit–terminating equipment. 

Do not repeat the common element in a series of hyphenated adjectives. 

Example:
Formatting examples include first-, second-, and third-level headings. 


	 
	comprise
(See compose and comprise)


	 
	contractions
Course materials are developed for an international audience and generally require a moderately formal tone of writing. The trend, however, especially in computer-based and Web-based training, is toward greater informality. Use contractions with discretion.


	 
	contrast between, contrast to, and contrast with
As a noun, contrast is used with either the preposition between or the preposition with. 
Examples:
You can immediately see the contrast between a network computer and a personal computer.
When explaining the network computer, it is important to show contrast with the personal computer.

As a verb, contrast is most commonly used with the preposition with rather than to.
Example:
Contrast the network computer with the personal computer.


	 
	cross-references
(See also above and below)
Cross-References to Another Book or Course
When referring students to another Oracle book or course, do not include the name or number of the chapter or lesson. Use a form like one of the following.

Examples:
For a list of all Oracle Process Manufacturing error messages, see the Oracle Process Manufacturing Reference Guide.
To determine whether a message carries parameters, refer to the definition of the message in the Oracle Process Manufacturing Reference Guide. 

Cross-References in the Same Course
Cross-reference lesson titles, not specific lesson numbers or page numbers. Place the exact title of the lesson in quotation marks, and use the phrase "the lesson titled."

Examples:
For more information, see the lesson titled "Specifying Profile Options."
This subject is discussed in "Communicating between Tiers" in the lesson titled "Determining Database Parameters."
   not
For more information, see page 3-10. 

Cross-References in the Same Lesson
Identify the area that you are referencing by using its title. Do not use above and below in cross-references to sections in the same lesson. For printed material, use preceding, following, earlier, next, or later instead; avoid the use of these terms in Web content. Use above and below sparingly to refer to content or objects on the same page in print publications and Web content. 

Cross-reference the title of the section, not a page number. Place the exact name of the section in quotation marks. It is not necessary to use the phrase "the section titled."

Examples:
For a list of options that you can set, see "Specifying Options," earlier in this lesson.
See the next section, "Specifying Options."

Cross-References to Figures and Tables
The preferred style is to start the sentence with "the following figure" (or "the following table") and to use active voice. As discussed in the preceding example, do not use above and below.
Example:
The following table describes the parameters that you can set.
   not
The parameters that you can set are described in the following table.

Cross-References on the Web
For Web content, refer to specific topics, lessons, and modules by name, rather than by using previous and next.


	 
	currency 
(See also numbers)
Spell out and lowercase monetary units.

Examples:
deutsche marks, dollars, euros, pounds, yen

Use the following abbreviations for currencies:

Currency

Abbreviation

Australian dollar

AUD

Belgian franc

BEF

British pound

GBP

Canadian dollar

CAD

Dutch guilder

NLG

euro

EUR

French franc

FRF

German deutsche mark

DEM

Hong Kong dollar

HKD

Indian Rupee

INR

Italian lira

ITL

Japanese yen

JPY

Mexican peso

MXN

Singapore dollar

SGD

Spanish peseta

ESP

U.S. dollar

USD

Use numerals for references to amounts of money. 

Example:
The suggested wholesale price is $150.
   not
The suggested wholesale price is one hundred and fifty dollars.

Express very large round numbers for amounts of currency as follows:

Example:
£5 million, $100 billion, $6 trillion

Use a comma in amounts of more than three digits unless you are referencing a number displayed on the screen that does not use a comma.

Example:
The price is $1,000.
   not
The price is $1000.


	 
	D


	 
	dashes 
(See also compound words and hyphens)
Do not put spaces before or after dashes, and do not use a hyphen with spaces to indicate a dash. 

Use an em dash (—) to indicate a break in thought or to set off an expanding or defining phrase. Note that an em dash is longer than either a hyphen (-) or an en dash (–). 

Examples:
Oracle General Ledger runs on any computer—mainframe, minicomputer, or PC.

A raw partition supports the same four operations—Open, Close, Read, and Write—as a file.

Note: Avoid em dashes whenever possible, by using parentheses or other punctuation.

Examples:
Oracle General Ledger runs on any computer: mainframe, minicomputer, or PC.
A raw partition supports the same four operations (Open, Close, Read, and Write) as a file.

Do not use em dashes in titles; use colons.

Examples:
Oracle Files Online: Concepts 
not
Oracle Files Online—Concepts

Do not use em dashes in navigation paths.

Use an en dash (–) to show continuing or inclusive items, such as numbers and dates. Note the length of the en dash. It is longer than a hyphen (-) and shorter than an em dash (—).

Examples:
0–9
1995–1999

Note: In text, it is preferable to express a range of numbers by using a prepositional phrase.

Examples:
from 0 through 9
between 1995 and 1999

Use an en dash in a compound adjective when one element of the compound consists of two separate words.

Examples:
operating system–specific guidelines
static page–intensive Web site

Note: Avoid this usage whenever possible by rewording the sentence.

Examples:
guidelines specific to your operating system 
a Web site with many static pages

When you do need to use an em dash, you can insert one as follows: 

Em Dash

Word

Turn on NumLock and press [Alt] + 0151 on the numeric keypad
or
Press [Ctrl] + [Alt] + [-] (the minus sign) on the numeric keypad. 
or
Navigate to Insert > Symbol, and select the em dash.

PowerPoint

Turn on NumLock and press [Alt] + 0151 on the numeric keypad.

Dreamweaver

Turn on NumLock and press [Alt] + 0151 on the numeric keypad. 
or 
Navigate to Insert > Special Characters > Other, and select the em dash.

Framemaker

Press [Ctrl] + [Q], then [Shift] + [Q].


When you do need to use an en dash, you can insert one as follows: 

En Dash

Word

Turn on NumLock and press [Alt] + 0150 on the numeric keypad.
or
Press [Ctrl] + [-] (the minus sign) on the numeric keypad. 
or
Navigate to Insert > Symbol, and select the en dash.

PowerPoint

Turn on NumLock and press [Alt] + 0150 on the numeric keypad.

Dreamweaver

Turn on NumLock and press [Alt] + 0150 on the numeric keypad. 
or 
Navigate to Insert > Special Characters > Other, and select the en dash.

Framemaker

Press [Ctrl] + [Q], then [Shift] + [P].

 


	 
	dates 
(See also numbers)
Use the standard U.S. format for general dates in text. 
Example:
The election took place on May 29, 2003
   not
The election took place on 29 May 2003.

Use the date format specified in the particular Oracle database.

Example:
Enter 29-MAY-05 in the Date field.
   not
Enter May 29, 2005, in the Date field.

Insert a comma after the year when the month and date are also given.

Example:
Entering a date of January 1, 2003, produces the desired result.
December 31, 2000, employee roster
   not
Entering a date of January 1, 2003 produces the desired result.
December 31, 2000 employee roster.


	 
	decimals 
(See numbers)


	 
	different from and different than
Use different from to compare parallel nouns.
Example:
The DOS interface is different from the UNIX interface.

Note: A better construction here is differs from rather than is different from.

Use different than when a clause follows the phrase. 

Example:
Modern computers are different than they used to be. 


	 
	do and perform
Use the word perform, not the word do, to describe performing a task or action.
Examples:
To set up the system, perform the following tasks: 
   not
To set up the system, do the following tasks: 

You must now perform the installation. 
   not
You must now do the installation.
Note: A better construction here is "You must now install the system."


	 
	done and finished
Do not use done when you mean finished. 
Example:
When you have finished entering a party, select New Record.
   not
When you are done entering a party, select New Record.


	 
	double-click 
(See click and double-click) 


	 
	due to 
(See because of and due to)


	 
	E 


	 
	ellipses
Generally, avoid using ellipses in course material, even when they appear in GUI elements. Ellipses can make machine translation difficult. If you must use them, consider the following guidelines:

Use an ellipsis to indicate an omission in code or in a quotation.

Example:
Calls to Application Foundation do not include semicolons, but SQL*Forms calls such as #EXEMACRO . . . ; must include a semicolon.

Do not use the ellipsis shortcut in Word ([Alt] + [Ctrl] + [.]) because it produces a single character.

Do not use an ellipsis as a substitution for the phrase "and so on."


	 
	em dashes 
(See dashes)


	 
	emphasis 
(See also writing principles: sentence structure)
To emphasize a word or phrase in text, use italic. Do not use all capital letters to emphasize text. For print publications, Do not use bold or all capital letters to emphasize text. Be careful not to overuse emphasis in text. 
For the Web, bold is the generally accepted standard for emphasis of text. Italic is generally discouraged on the Web because it is difficult to read.

Note: On the Web, italic may be used in some cases to indicate references and publication titles in order to avoid confusing underlined text with hyperlinks.


	 
	en dashes 
(See dashes) 


	 
	enable 
(See allow, enable, let, and help)


	 
	ensure 
(See assure, ensure, insure) 


	 
	equations 
(See also numbers)
Develop equations in good sentence form. The signs are substitutes for words. 
Example:
A + B = C reads “A plus B equals C.”

When you use an equation, substitute letters for the quantities and define them, or spell out the quantities.

Examples:
Hit ratio is defined as follows:
   HR = (LR – PR) / LR 
where:
   HR = Hit ratio 
   LR = Logical reads 
   PR = Physical reads
   or 
Hit ratio is defined as follows:
   Hit ratio = (Logical reads – Physical reads) /
   Logical reads

Put a space on each side of the signs of operation. 

Example:
A × B = C 
   not
A×B=C 

Use an en dash (–) rather than a hyphen (-) to indicate subtraction, and use the multiplication sign (×) rather than the letter x to indicate multiplication.

Do not use mathematical symbols to replace words in general text.

Example:
To ensure that multiblock reads can be performed effectively, you should provide an extent size equal to or greater than 32,768 bytes.
   not
To ensure that multiblock reads can be performed effectively, you should provide an extent size > 32,768 bytes.


	 
	e-terms
The style guidelines for "e-business," "e-commerce," "e-mail," and other such terms are as follows:

For proprietary Oracle terms, use a lowercase e (without italics) followed by a capital letter. For example: eStudy, eSeminar, and eClass (also inClass).

Otherwise, include a hyphen and capitalize the term like any other compound word: no capitalization in the middle of a sentence, capitalize the E only at the beginning of a sentence, and capitalize both the E and second letter in titles and headings.

Example:
E-Marketing
E-marketing is the future of e-business.

Note: The preceding standards are for text only. There are separate graphic standards for using "e-business" with the Oracle logo. Please refer to these standards at http://design.us.oracle.com/.


	 
	exclamation marks
Do not use exclamation marks. They are more appropriate for advertising than for technical writing.
Generally, because of the greater informality of the Web, exclamation marks are more acceptable in some Web-based content, such as dialogs and scenarios. 


	 
	F 


	 
	farther and further
Use farther to specify physical distance. Use further to convey time, degree, or quantity.
Examples:
farther than the airport
a further discussion


	 
	fewer and less
Use fewer to modify plural nouns and countable items. 
Example:
Fewer employees work on the sixth floor than on the fourth.

Use less to modify singular nouns that indicate quantity or bulk.

Example:
The old copy machine holds less paper than the new one.


	 
	fractions 
(See numbers)


	 
	future tense
(See verbs: tense)


	 
	G 


	 
	gender
Do not use he, him, and his to include both men and women or to refer to a user or other person whose gender is unknown or irrelevant. You can avoid this construction in a number of ways. 
Rephrase the sentence so that the pronoun is plural. 

Example:
When users log in, the first thing that they see is a welcome screen. 
   not
When the user logs in, the first thing that he sees is a welcome screen. 

Note: Do not use a singular object with the plural pronoun they. Although this construction is common in speech, it is not acceptable in writing.

Example:
When users log in, the first thing that they see is a welcome screen. 
   not
When the user logs in, the first thing that they see is a welcome screen. 

Use the construction he or she.

Note: This construction is acceptable, but be careful not to overuse it. It can be distracting to the reader. 

Example:
When the user logs in, the first thing that he or she sees is a welcome screen. 

Note: Never use constructions such as he/she, s/he, (s)he, he (she).

Reword the sentence to eliminate the pronoun. 

Example:
The Registration window appears as soon as the user logs in.

Address the reader directly. 

Example:
When you log in, the first thing that you see is a Registration window. 

Although it is not usually preferable, you can use a passive construction. 

Example:
After the user logs in, the first thing that is displayed is the welcome screen. 


	 
	gerunds
(See also titles)
A gerund is a verb form that ends in -ing and functions as a noun. Use gerunds to form titles. 
Task-oriented lesson titles 

Example:
Navigating the Designer 

Task-oriented headings (first-level topic titles)

Example:
Customizing Menus 

Task-oriented subheadings (subtopic titles)

Example:
Creating an Individual Menu 

Guided practice titles 

Example:
Guided Practice: Navigating the Designer 

Note: Avoid beginning titles and headings with the gerund Using, which is usually vague and can be repetitive. Choose a word that is more specific to the immediate task.


	 
	graphic, graphical, and graphics
Use graphic as an adjective to mean vivid or pictorial. Use graphic as a noun to mean a picture, image, chart, or display. 
Examples:
a graphic description of the film (adjective) 
creating a graphic using the drawing tools (noun) 

Use graphics as an adjective when referring to software. 

Example:
a graphics application 

Use graphical to refer to an environment.

Example:
a graphical user interface 


	 
	graphics labels
Present graphics labels, also known as callouts, in initial cap and lowercase. Capitalize proper names, such as Oracle Payables, used in graphics labels.

Example:

not
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	GUI conventions
(See also typographic conventions)

GUI Elements and Capitalization
Refer to all objects within the GUI, such as menus and toolbars, in the case in which they appear on the screen. 

Examples:
the File menu
the Comments tab

If a graphical user interface (GUI) element, such as a field name, consists of several words that appear on the screen with an initial capital letter only, put the name of that element in quotation marks to distinguish it from surrounding text. 

Example:
Select the “Include a reusable module component” check box and click Finish.

If a GUI term is spelled with caps/lowercase, do not enclose the term in quotation marks. The capitalization style should set the term off from surrounding text.

Example:
Modify the DOCTRL - Record List Template Filename preference.


	 
	GUI Terminology Guidelines 
When to use select and choose: 

Use select for menu options, option buttons, check boxes, ranges of text, and items from lists of values. 

Examples:
Select File > Save. (Menu option)
Select Landscape. (Option button) 
Select the Print to Black and White check box.
Select the text that you want to delete. 
Select Reports and click OK. (Item from a list of values) 

Use choose only when select becomes repetitive. 

Example:
Choose the selected item. 

When to use click and double-click:

Use click for interface buttons and icons. 

Example:
To print your receipt, click Print.

Use double-click for program icons. 

Example:
To start Enterprise Manager, double-click the Oracle program icon. 

When you refer to a dialog box, do not call it a window. 

When you describe a window that is opening, use is displayed, opens, or appears. Do not use the term displays. 

Examples:
The Find window is displayed. 
The Find window opens. 
The Find window appears. 

When you describe how to close a window, use the phrase “Close the window.” 

Use click and double-click, not click on and double-click on. 

When describing a drag-and-drop operation, use the phrase “Drag the object to the other object.” Do not use the phrase “Drag-and-drop the object.” 


	 
	Definition of GUI Terms and Recommended Usage
Term

Definition or Comment

alert

An area that contains a warning or an error message that you must acknowledge (by clicking a button) to continue

alt text

HTML attribute that provides alternative text when nontextual elements, typically images, cannot be displayed

alternative region

A region is a logical grouping of fields in a window; an alternative region is one of a series of regions that you can select. When you select an alternative region, the fields in that part of the window change to reflect the new selection. Names of alternative regions are caps/lowercase—for example, "the Source Information alternative region. "Do not use alternate region or stacked region.

arrow buttons






Use the terms left arrow (or left-arrow button if necessary for clarity) and double left arrow (or double left-arrow button for clarity). The same style applies for right, up, and down arrows. Recommended Usage: “Click the left arrow.” “Click the double right arrow.” “Click the up-arrow button.”

block




Do not use as a synonym for region. The only instance in which block should be used as a GUI term is to describe a table in the user interface that is based on a particular table in the database.

button





A button is a graphic element that initiates a predefined action when clicked or selected. Buttons do not store values. Recommended Usage: Use select when given a choice of option buttons. Use click when referring to interface buttons. 

cascade (n, adj)

An arrangement style for windows

check box








A check box (two words) is an element that can be toggled on or off. Names of check boxes are caps/lowercase, but the term check box itself is not: “the Allow Updates check box.” Use select and clear for check boxes. Do not use click, choose, check, deselect, uncheck, or similar terms. Recommended Usage: “Select the Allow Updates check box” and “Clear the Allow Updates check box.” 

choose

Use only if select becomes repetitive. See select.

clear

Use when you mean to cancel the selection of an option button or check box. Do not use deselect.

click/double-click,
left-click/right-click,
[Ctrl]-click/ [Shift]-click


Use with interface buttons and icons; use only when describing the action of actually pressing the mouse button. These terms are always hyphenated. You click buttons; you do not click on them. However, you can click in a field. Recommended Usage: “To start Forms, double-click the Oracle program icon.”

collapse, expand

Refers to a folder or outline. You click a plus or minus sign next to the folder to collapse or expand it so that you can see more or fewer subentries.

color palette

Area in a window for specifying colors

command window

Use to refer to a DOS-style window.

context-sensitive menu

A menu that highlights options as available or unavailable depending on the context in which the option is called

cursor

In applications and operating systems that use a mouse, the arrow or other on-screen icon that moves with movements of the mouse; also, an on-screen indicator, such as a blinking underline or rectangle, that marks the place at which a keystroke appears when typed.

delete

Use instead of remove.

deselect

Do not use. Instead, use clear when you mean to cancel the selection of highlighted text.

dialog box




A nonscrollable area that displays the options currently available. Dialog boxes contain command buttons and options. You must select one of the options before continuing. Use instead of dialog or dialogue box. Do not call a dialog box a window. Unlike a window, a dialog box does not have a menu bar. 

dimmed

Do not use; instead, use disabled.

disabled

Indicates that a screen element cannot be used in the current context; use instead of dimmed or grayed out. 

double-click



To press and release the mouse button twice without moving the mouse. (See the preceding section, “GUI Terminology Guidelines,” for examples of usage.)

drag





To move objects with the mouse. Do not use the phrase drag-and-drop as a verb. The action of dragging includes dropping the element in place. Drag-and-drop is acceptable as an adjective. Recommended Usage: "Drag X to Y”; not “Drag-and-drop X into Y.” 

drop-down list

A box that drops down a list of options when selected. Generally, avoid using drop-down unless you must describe how the list works or what it looks like. Recommended Usage: "Special list"; not "Special drop-down list"

drop-down menu


A menu that drops from the menu bar when you select it and that remains open automatically. (Do not use pull-down menu.) Do not use drop-down unless you must describe how the menu works or what it looks like. Recommended Usage: "Format menu"; not "Format drop-down menu"

enabled

Indicates that a screen element can be used in the current context

enter





Use enter instead of type, input, or key in, except in certain computer-based training materials, where you must use type. 
Use enter for text fields, into which you physically type a value, as opposed to fields in which you select a value from a list.

expand, collapse

Refers to a folder or outline. You click a plus or minus sign next to the folder to expand or collapse it so that you can see more or fewer subentries.

field


An area of a dialog box, property sheet, or window that either displays data or enables you to enter data

Find window


A window that opens automatically when you enter certain windows, in which you can query information based on criteria that you specify

folder

A directory in a GUI context

form


A single window or box, or a series of related windows, in which you enter information 

frame

A rectangular section of the page displayed by a Web browser, which is an HTML document separate from the rest of the page. Web pages can have multiple frames, each of which is a separate document. Like other Web pages, a frame has scrolling and linking capabilities. Frames are often used as a table of contents for one or more HTML documents on a Web site. Use frame instead of pane when describing Web pages.

grayed out

Do not use; instead, use disabled. 

group box

A standard control used to group a set of options in a dialog box. Avoid using in end-user documentation.

highlighted (adj)

Refers to a selected piece of text

hyperlink

(See link) 
Recommended Usage: Hyperlink and link are equivalent terms and may be used interchangeably. Use one term consistently in courseware.

icon

A graphic representation of an object, attribute, or program

icon button











Use icon or icon button, not iconic button. Spell out the name of the icon that appears when you place the cursor over it. If the name of the button can easily be confused with another button, it is acceptable to describe the image on the button (for example, “Click the green check mark button”). When icons have keyboard equivalents, you can place the icon in parentheses after the icon name for clarity. Do not use an icon without also spelling out its name. Recommended Usage: “Click the Plus (+) button”; not “Click +.” 

link

A connection between an element in a hypertext document and a different element in the document, another document, a file, or a script. The user activates the link by clicking the linked element, which is usually underlined or in a color different from the rest of the document to indicate that the element is linked. Recommended Usage: Link and hyperlink are equivalent terms and may be used interchangeably. Use one term consistently in courseware.

list

A data structure containing zero or more nodes that are linked together in a hierarchical fashion. Use list instead of tree.

list box

A generic term for any type of dialog box option containing a list of items that the user can select. Refer to a list box by its label and the word list, not list box.

list of values (LOV)

Use list of values instead of QuickPick, which refers to character mode.

menu

A list of application commands. Do not use "drop-down menu" unless you must describe how the menu works or what it looks like. 

menu bar

A bar that displays names of menus 

menu command

Any one of a list of options displayed on a menu. Do not refer to a command as a menu item, a choice, or an option.
You can click commands on a menu, and you can also select commands from a menu.

multirecord block

A block consisting of several records

navigation list

A data structure containing zero or more nodes that are linked together in a hierarchical fashion. Use list instead of tree.

navigation tree

See navigation list
navigator

A control for selecting a directory or folder from a file system. A navigator contains a list control in a scroll box. 

node

A location on a list structure that can have links to one or more nodes below it. You expand and collapse nodes. (See also list)

option button


A button that belongs to a group from which only one can be selected. Do not use radio button. Use click, rather than select, with option buttons.

page

Refers to one of a collection of Web documents that make up a Web site. Use page to refer to the page that the user is on or to a specific page such as a home or start page.

pane

Use only to refer to the separate areas of a split or single window. Do not use region when you mean pane. Use frame instead of pane when referring to Web pages.

point

Use point to to mean positioning the mouse pointer at a location on the screen. Also use point to in procedures that involve submenus that you do not click: "Click Start, point to Settings, and click Printers."

pop-up list

A box that appears with a list of options when selected; do not use poplist or pop-list.

pop-up window

A window that appears when an option is selected (for example, a Check Answer button in a quiz)

portal

Web site that serves as a gateway to the Internet 

portlet

Region in a portal that contains customized content

pull-down menu

A menu that is opened by clicking and holding a menu bar option then pulling down the menu items. Do not use to mean drop-down menu.

radio button

Do not use; instead, use option button.

record




Use record instead of row to refer to a record in the window, which may correspond to one or more rows in a database table. You can use either record or row when referring to rows in the database tables.

region



Use region instead of zone or block to describe a logical grouping of fields. Capitalize names of regions, such as “the Repetitive Planning region.” 

right mouse button

Do not use; instead, use right-click.

save

Generally, use save instead of commit. In SQL, commit is the process that allows data changed by one application or user to be used by other applications or users.

scale

Graphical interface for editing numeric values

screen

The display area of a computer monitor. Do not use screen to mean window.

screen pop

A CRM-specific term in which pop refers to populate, meaning that information in a form appears automatically

scroll



To move continuously through a document or window (forward, backward, or sideways) by using the scroll arrows, scroll bars, and scroll boxes

scroll arrows


Arrows on the scroll bars of a document or window that you use to move one line or increment at a time

scroll bar


Bars at the side and bottom of a document or window that you use to move quickly through the document or window in jumps 

scroll box




A small box, also called an elevator, inside a scroll bar. You move the box to scroll quickly through the document. The scroll box also indicates your current position in the document. 

select





Use select to indicate choosing a check box, an option button, or an item from a menu or a list of values, or to mark a range of text for a user action. Use select instead of highlight, press, punch, or push. Use choose only if select becomes repetitive.

shortcut menu 

A menu opened by right-clicking the mouse on a GUI element. Use shortcut menu instead of right mouse menu.

status line

An area in a window that shows status information

submenu

A menu displayed as the result of a previous menu selection

subtab

A tab displayed as the result of a previous tab selection

tab


Refers to a tab in a window. (See also tabbed pages) For other uses, clarify the meaning: the [Tab] key, a tab stop, or a tab mark on the ruler.

tabbed page


Labeled group of options used for many similar kinds of settings; you access a tabbed page by clicking a tab.

text box 

An area within a dialog box or an HTML form where the user can enter text. Use text box instead of entry field.

title bar

Area that shows an application or window name 

tool palette

Area in a window that contains editing and viewing tools

toolbar

Area in a window that shows available tools

toolbar icons

Toolbar icons are considered buttons and are sometimes referred to as icon buttons. 

tree

Avoid tree; instead, use list. (See list) 

viewlet

Animated step-by-step training and product demonstration that you can view in a Web browser

Web page

See page
window




An area on the screen in which you interact with an application. Unlike dialog boxes, windows are usually scrollable, and you can control their size and shape. Windows also contain menus. Do not use window to mean dialog box, form, or screen.

wizard



Lowercase in generic usage. In reference to a feature that guides you through a process, use caps/lowercase, such as the Report Wizard.




	 
	H 


	 
	he and she 
(See gender)


	 
	headings 
(See also titles)
Headings

The heading introduces a topic. Headings can appear anywhere on the page. In print publications, headings are continued on following pages, with the word (continued) in parentheses. Each page must begin with a heading, either directly beneath the slide or, if there is no slide, at the top of the page.

For inClass or ILT course materials, the heading format is Arial 12 pt. bold, caps/lowercase.

For Web content, follow the heading conventions of the current templates.

Note: Do not use (continued) in slide titles.

Subheadings

The second level of heading, the subheading, introduces a subtopic under the main topic. If this subtopic continues to another page, the subheading should be continued as well, followed by the word (continued) in parentheses. Most subheadings should not continue to the next page, however, because the subtopic they introduce should be brief. If a course has too many continued subheadings, divide the information into additional subtopics.

For inClass or ILT course materials, the subheading format is Times New Roman 12 pt. bold, caps/lowercase.

For Web content, follow the subheading conventions of the current templates.


	 
	Help 
Use the term Help instead of help text. Make sure to capitalize the word Help when you refer to any Help system.
Example:
You can get help by using online Help. 

To reference a Help topic, enclose the topic title in quotation marks. Follow the capitalization that appears in the link. 

Example:
In online Help, click the “Data diagram elements and notation” link.


	 
	hyphens 
(See also compound words and hyphens)
Do not use hyphens to separate parts of a title or heading. If your title has two parts, use a colon to separate them.

Example:
Data Compression Optimization: Enabling Row Movement
  not
Data Compression Optimization - Enabling Row Movement 

Do not use hyphens (or dashes) to indicate items in a list. Always use bullets in an unordered list.

Example:
• Classes
• Methods
• Functions
  not 
- Classes
- Methods
- Function


	 
	I 


	 
	if and should
(See American and British usage) 


	 
	if and then
(See translation, writing for)


	 
	if and whether
Use whether to introduce a noun clause. Although it can be used in most constructions, it leads to ambiguity when the noun clause begins a sentence and in other constructions.
Examples:
She asked whether we would attend the meeting. 
   not
She asked if we would attend the meeting. 

Whether we were coming to the meeting was the point of her question.
   not
If we were coming to the meeting was the point of her question. 

You must define certain basic global data values, whether you intend to use the standard or the actual costing method. 
   not
You must define certain basic global data values, if you intend to use the standard or the actual costing method. 


	 
	imply and infer
Use imply in relation to writers and speakers. It means to hint or suggest. 

Example:
The speaker implied that no action would be taken.

Use infer in relation to readers and listeners.

Example:
I infer from what you said that the plan has been abandoned.


	 
	in and on
(See prepositions)


	 
	infinitive phrases
An infinitive is a verb form that is used with to. Generally, do not place an adverb between the word to and the verb that follows it if the adverb can be placed elsewhere in the sentence.

Example:
This lesson shows you how to use the Land application to update general ledger accounts automatically.
   not
This lesson shows you how to use the Land application to automatically update general ledger accounts.

Sometimes a split infinitive is acceptable if it yields a more natural and economical sentence.

Example:
By implementing the Oracle E-Business Suite, the XYZ Company expects to more than double its profits. 
   not
By implementing the Oracle E-Business Suite, the XYZ Company expects to double its profits by more than two times.

Use a comma after an introductory infinitive phrase.

Example:
To log on the the database, enter your username and password.


	 
	instructor notes
(See also notes; technical notes)
Instructor notes give additional information that facilitate the delivery of the course. Use the heading "Instructor Note," singular, with no colon following the text.

Example:
Instructor Note
   not
Instructor Notes:


	 
	insure 
(See assure, ensure, insure) 


	 
	intransitive verbs 
(See verbs: Intransitive and Transitive Verbs) 


	 
	italic type
(See also emphasis; writing principles)
Follow these general guidelines for the use of italic type:
Use italic sparingly to emphasize a word in text.
Avoid the use of italic on the Web. Instead, use bold for emphasis.

Note: On the Web, italic can be used to indicate references and publication titles in order to avoid confusing underlined text with hyperlinks.

It is not necessary to use italic for terms that are preceded by phrases such as “known as,” “stands for,” and “called.” 

Example:
OEM stands for Oracle Enterprise Manager. 
   not
OEM stands for Oracle Enterprise Manager.

Use italic when you refer to words as words and letters as letters.

Examples:
Use an and after the comma in a compound sentence. 
Distinguish between the letter o and the number 0. 

Use italic when you refer to course or book titles. 

Examples:
For a general overview of structured query language, take the course Introduction to SQL.

The course developer needs a copy of the Oracle Applications User’s Guide. 

Set commas, colons, and semicolons in the typeface of the preceding word. Set periods, quotation marks, question marks, and parentheses in the type style of the surrounding text. 

Use Courier New italic for syntax variables. 
(See typographic conventions) 

Example in text:
In this syntax, database_string is a host variable that identifies a server. 

Example in code:
CREATE ROLE role 


	 
	J 


	 
	jargon 
(See also translation, writing for; writing principles)
Do not use jargon, slang, buzzwords, idioms, or figures of speech. These terms or phrases are usually specific to cultures, especially terms that refer to folklore and sports. Jargon developed in one language may not have a meaning or equivalent in another language.
Examples:
design your program from scratch (from track and field) 
cover your bases (from baseball)

It is acceptable to define and use technical terms that are specific to a product.


	 
	Java 
(See also abbreviations and acronyms; terminology)
Java, an object-oriented programming language released by Sun Microsystems in 1995, has had a profound effect on online applications. Java programs can be run on any computer that has a Java interpreter (called a Java Virtual Machine), which is included in most Web browsers. Programmers use Java to provide dynamic content, such as graphics, motion, and sound. Java-enhanced Web pages enable interactive applications such as simulations and computer-based training. Java output is bytecode, a code form between machine code and source code, which can easily be transmitted across networks, including the Internet.

Java terms and acronyms that appear commonly in Oracle courseware include:

Term
Comment
applet

 

DM4J

Data Mining for Java

EJB

Enterprise JavaBeans. EJB is the server-side component architecture for the J2EE platform. Enterprise JavaBeans usually refers to the technology. The singular Enterprise JavaBean is occasionally used to refer to a specific component of the technology. 

J2EE

Java 2 Platform, Enterprise Edition

J2ME

Java 2 Platform, Micro Edition

J2SE

Java 2 Platform, Standard Edition

JAAS

Java Authentication and Authorization Service

JAE

Java Application Environment

JAIN

Java APIs for Integrated Networks

JAR

Java Archive. File format used to bundle files in a single archive file

.jar file

Individual file that is bundled with others using the JAR file format. You can package class files, audio files, and image files in a .jar file.

JavaScript

A scripting language embedded within HTML; the most significant scripting language for the Web. (JavaScript is not to be confused with Java the object-oriented programming language and is not a creation of Sun Microsystems.)

JavaSoft

A Sun Microsystems company

JAXB

Java Architecture for XML Binding

JAXM

Java API for XML Messaging

JAXP

Java API for XML Processing

JAXR

Java API for XML Registries

JAZN

Java Authorization

JBuilder

An IDE

JClient

 

JCA

J2EE Connector Architecture

JCP

Java Community Process

JDBC

Java Database Connectivity

JDeveloper 

The Oracle IDE for developing Java applications

JDK

Java Development (or Developer's) Kit

JFC

Java Foundation Classes

JMS 

Java Message Service (an API)

JRE

Java Runtime Environment

JServer 

The server-side Java engine incorporated into the Oracle8i database

JSP

JavaServer Pages. A Java API; a dynamic Web page–generation technology. JavaServer Pages (note the s) refers both to the API and the technology. JSP (singular) can also mean an individual JavaServer Page, and JSPs means multiple JavaServer Pages.

JSR

Java Specification Request

JSSE

Java Secure Socket Extension

JTA 

Java Transaction API

JTS

Java Transaction Service

NetBeans

An IDE

OC4J

Oracle9iAS Containers for J2EE

Oracle9iAS Java Edition

 

OracleJVM

Oracle Java Virtual Machine

ORMI

Oracle Remote Method Invocation

SQLJ 

SQL for Java. A technology that enables a Java program to access a database by using embedded SQL statements.




	 
	Java typographic conventions
Element
Typographic Style
Example
attributes

Lowercase Courier New

align
codebase
height 
class types

Case-sensitive plain text
Note: Avoid overusing; it is often preferable to use specific class names.

character
vector
writer 

class names

Case-sensitive Courier New

BeanInfo
Jseparator
FilterReader
constants

Uppercase Courier New

SC_NOT_FOUND
containers

Lowercase plain text

heavyweight
panel
top-level 

events

Lowercase plain text

event handler
event listener
event source 

exceptions

Case-sensitive Courier New

InterruptedException
PropertyVetoException 
files

Case-sensitive Courier New

font.properties
file names

Lowercase Courier New

.ear
.jar
.war 
interface types

Courier New

Externalizable
Runnable
Serializable 
interface names

Courier New

FilenameFilter
java.io.Serializable
keywords

Lowercase Courier New

catch
finally
return 
method names

Case-sensitive Courier New

accept()
addElement()
canRead() 
operators

Lowercase plain text

dot (.)

packages

Lowercase Courier New

java.beans
java.io
javax.swing 
parameters

Lowercase Courier New

archive
code
codebase
states

Courier New

dead
new thread
not runnable
values

Case-sensitive Courier New

Return type
variables

Lowercase Courier New

final
private
static 
  

	 
	job titles and roles
Do not capitalize job titles that are used in place of names.
Example:
The system administrator grants user permissions. 
Enter the name of the sales representative.

Capitalize the names of roles in a SQL programming context, where a role is a privilege or a set of privileges that allows a user to perform certain functions in the database. Roles are assigned by a DBA.. 

Example:
Log in as System Administrator. 


	 
	K 


	 
	key combinations 
Use plus signs to indicate keys that should be pressed simultaneously. Insert a single space before and after each plus sign.

Example:
Press and hold [Ctrl] + [Alt] + [Delete].


	 
	key sequences 
Use commas to indicate keys that should be pressed and released in sequence. 

Example:
Press and release in succession [Alt], [F], [D].


	 
	keyboard terminology 
(See also GUI conventions)
You press function and terminal keys; you do not depress, hit, push, or strike them. 
You enter information by way of the keyboard; you do not type in or key in information. 

Enclose the names of function keys in brackets. When you use brackets, you do not need to add the word key.

Examples:
Press [Clear Record].
Press [F7].

Use caps/lowercase and brackets for terminal keys and named keys on a keyboard.

Example:
Press [Alt], [Shift], [A].


	 
	L 


	 
	later
(See release and version)


	 
	Latin words and abbreviations
(See also abbreviations and acronyms)
Do not use Latin abbreviations in text. Use the English equivalents.
Do Not Use

Use

e.g.

for example

etc.

and so on

i.e.

that is

Latin abbreviations can be used sparingly in tables, graphics, or wherever space is limited. Insert a comma following e.g. and i.e.
Some common Latin words, such as via, versus, and vice versa, are acceptable in technical writing. However, use foreign words and phrases with discretion. Consult a dictionary to determine proper usage. 

If you must use a Latin word, do not italicize it. Use regular type; for example, “ad hoc” not “ad hoc.” 

Do not hyphenate Latin expressions in adjectival form.

Examples:
ad hoc meeting 
a priori reasoning 

Note: In SQL, an ad hoc query is a temporary query, as opposed to a permanent query. 


	 
	less
(See fewer and less)


	 
	let 
(See allow, enable, let, and help) 


	 
	letters as letters
(See italic type)


	 
	like and such as
Do not use like to mean such as. Use such as to introduce examples and like to indicate resemblance. 
Example:
Like other technology companies, Oracle offers employee benefits such as paid vacation, paid holidays, a 401k plan, and medical and dental insurance. 


	 
	Linux
(See also abbreviations and acronyms)
Pronounced lih-nucks. A freely distributable open-source operating system that runs on a number of hardware platforms. The Linux kernel was developed mainly by Linus Torvalds. Because it's free, and because it runs on many platforms, including PCs and Macintoshes, Linux has become an extremely popular alternative to proprietary operating systems. 

Linux and Linux-related terms and acronyms that may appear in Oracle courseware include: 

Term
Comment
bash

Bourne-again shell

BSD

Berkeley Software Distribution

copyleft

Antonym of copyright; a legal instrument that requires those who pass on a program to include the rights to use, modify, and redistribute its code

FreeBSD

 

FSF

Free Software Foundation

GIMP

GNU Image Manipulation Project

GNOME

GNU Network Object Model Environment

GNU (project)

GNU's not UNIX

GPL

General Public License

GTK

GIMP Toolkit

KDE

K(ommon) Desktop Environment

Mozilla

 

Nautilus

 

open source (n)
open-source (adj)

 

OpenBSD

 

Red Hat

 

RPM

Red Hat Package Manager

Samba

 

SuSE

 

UnitedLinux

 

WindowMaker

 

X Window System

 

  


	 
	lists 


	 
	List Development 
Follow these general guidelines in creating all types of lists. (See also colons)
Put information in a list if your goals are to:

· Simplify complex material 

· Break up a long paragraph 

· Indicate sequential steps 

· Compress repetitive wording 

· Provide a checklist

Use the list format judiciously. Do not put every sentence or small group of sentences into a bulleted list. Often, information is more effectively presented in paragraph form. 

Include at least two list items (preferably three or more). Never create a list with only a single list item.

Introduce a list with a lead-in sentence, sentence fragment, or block label. End the lead-in sentence or sentence fragment with a colon. 

Examples:
The table contains the following columns: (complete sentence)
The columns in the table are: (sentence fragment)
Table Columns (heading)
Avoid beginning each list item with the same word or phrase. Instead, incorporate the common word or words in the lead-in sentence.

Example
The lesson also shows you how to reconfigure and resize the following:
   • Windows
   • Toolbars
   • Drop-down menus
   not
The lesson shows you how to do the following:
   • Reconfigure and resize windows 
   • Reconfigure and resize toolbars
   • Reconfigure and resize drop-down menus

Capitalize the first word of all items in a list. 

Use periods with list items only if they are complete sentences. 

Example 1:
Use the ACCEPT command to: 
    • Explicitly define a NUMBER or DATE data
        type variable
    • Hide user input for security reasons 

Example 2:
The ACCEPT command functions differently depending on whether or not a variable exists:
    • The ACCEPT command creates a variable 
        if the variable does not exist. 
    •  If a variable does exist, the ACCEPT
       command automatically redefines it. 

When a list contains both sentence fragments and full sentences, do not include periods after the fragments but do include periods after the sentences. 

Note: Develop list items in a consistent style, that is, all fragments or all sentences. Then punctuate accordingly: no periods after fragments and periods after full sentences. 

Use parallel construction for all items in a list.

Examples:
You should now be able to perform these functions:
•Customize Web requisition forms
• Add default functionality 
• Add custom account building logic 
   not
You should now be able to perform these functions: 
• Customize Web requisition forms 
• Adding default functionality 
• You can also add custom account building logic


Objectives Lists
An objectives list appears at the beginning of each course, unit, module, and lesson. 
Begin all lists of objectives for courses, units, modules, and lessons with the following sentence: "After completing this course (unit, lesson), you should be able to do the following:"

Under this introduction, create list items that are sentence fragments beginning with imperative (action) verbs. Do not use end punctuation. 

Example:
After completing this lesson, you should be able to do the following:
• Start Oracle Sales Compensation 
• Use the toolbar and function keys

If the objectives cover only one topic, incorporate that topic in the "After completing this lesson..." sentence. Do not create a one-bullet list.

Example:
After completing this lesson, you should be able to print a report. (Note the end punctuation.)
   not
After completing this lesson, you should be able to do the following: 
• Print your report

Definition Lists
A definition list defines or explains terms. 
Use bullets in definition lists. 

Use a colon, not an em dash, to separate the term from its definition.

Use roman type, not italic or bold, for the term.

If possible, keep definitions consistent, with either complete sentences or sentence fragments. 

Example 1 (complete sentences; note end punctuation)
When viewing large report pages, you can split the Previewer window either horizontally or vertically.
• Horizontal split: Click and drag the gray rectangle
   above the vertical scroll bar.
• Vertical split: Click and drag the gray rectangle to
   the left of the horizontal scroll bar. 

Example 2 (sentence fragments; no end punctuation) 
The sort table options are:
• Column: Enters the name of the column
• Direction: Specifies whether to sort the data from
   high or low
• Group: Specifies the type of break 

Note: If the definition or explanation consists of a fragment followed by one or more full sentences, end the fragment with a period. It is preferable, however, to use either all fragments or all complete sentences. 

Example:
Customer: The name of the customer. You must enter a customer to be able to book an order. 

Practice Overview Lists
A practice overview introduces practices and appears wherever it is needed in a lesson. 
Begin practice overview lists with the following introduction: “This practice covers the following topics:”

Begin each list item with a gerund (a verb ending in -ing). Do not use end punctuation. 

If the practice covers only one topic, incorporate that topic in the "This Practice covers..." sentence. Do not use a one-bullet list.

Example:
This practice covers recovering your data. (Note the end punctuation.) 
   not
This practice covers the following topic: 
    • Recovering your data

Summary Lists
A summary list appears at the end of each course, unit, module, and lesson. You can format the summary slide in many ways. For example, you can summarize the lesson or unit in a couple of sentences, you can use a graphic or table, or you can combine these presentations or use others. Whatever format you choose, use it consistently throughout your course.
If you decide to simply restate the objectives, try not to repeat the objectives verbatim. Use the following guidelines for summary lists:

Begin the summary list with this introduction: “In this lesson, you should have learned how to:” 

Under this introduction, create list items that are sentence fragments beginning with imperative (action) verbs. Do not use end punctuation. 

If the summary covers only one topic, incorporate that topic in the "In this lesson..." sentence. Do not create a one-bullet list. 

Example:
In this lesson, you should have learned how to define a parameter. (Note the end punctuation.) 
   not
In this lesson, you should have learned how to: 
    • Define a parameter

Numbered Lists 
(See also procedures) 
Use numbered lists for procedures or processes that follow a sequence. 

Introduce a numbered list with either a heading or a complete sentence ending with punctuation.

Use a complete sentence ending in punctuation for each item in a numbered list.

Example of list following a heading:

How to Create a Static List of Values
1. In the Parameter property palette, select the List of Values property.
2. Enter a value in the Value field and then click Add.
3. Repeat steps 1 and 2 for each value that you want to add to the list.

Example of list following an introductory statement: 

The Enter Parameter Values dialog box appears after this sequence of events occurs: 
1. A user-named parameter is referenced in a menu item command.
2. A call is made to a built-in procedure in a PL/SQL subprogram. 


	 
	log in and log on
Use the verb log in when you refer to beginning a session in an application.

Use the verb log on when you refer to establishing a connection to an operating system, machine, or network.

Note that log in and log on are phrasal verbs (verb + preposition.) Do not use the prepositions into or onto following the verb log.
Example
Employees can log in to Oracle Calendar to access calendar, schedule, and personal information management (PIM) capabilities. Only users with valid IDs can log on to the network.
   not
Employees can log into Oracle Calendar to access calendar, schedule, and personal information management (PIM) capabilities. Only users with valid IDs can log onto the network.

As nouns or adjectives, spell login or logon as one word.


	 
	lowercase letters 
(See capitalization) 


	 
	M 


	 
	may 
(See can and may) 


	 
	may and might 
(See also can and may)
Use may to mean possibility. Use might to express past tense or a hypothetical situation. 
Examples:
You may need to increase the memory in your hard drive to install this software.
If his price had been lower, he might have won the bid for the job. 


	 
	more than and over
(See over and more than) 


	 
	mouse terminology 
(See also GUI conventions)
Refer to the mouse buttons as follows:

· The left mouse button 

· The right mouse button 

· The center mouse button

You right-click an object; you do not press the right mouse button on an object or to invoke an object.

You right-click to open a shortcut menu.

You press mouse buttons; you do not depress or click them. In most technical writing, however, use the terms click or right-click to refer to the specific GUI element that is the object of interaction with the mouse.

Lowercase the names of mouse pointers: the cursor, the pointer, the magnifying glass, and the hourglass.

The plural of mouse is mouse devices.


	 
	must, have to, need to, and should
Use must to imply necessity, not have to, need to, or should. 
Examples:
To install Oracle General Ledger, you must perform the following prerequisites. 
   not
To install Oracle General Ledger, you need to perform the following prerequisites. 
or 
To install Oracle General Ledger, you should perform the following prerequisites.

Note: An exception to this rule is in the case of a negative sentence. 

Example:
You do not need to enter your password a second time. 

Use should to imply probability or expectation. 

Example:
In this lesson, you should have learned how to do the following tasks. 


	 
	N 


	 
	navigation paths
Oracle applications courses use simplified navigation paths to direct the user through Oracle University courses. The navigation path often appears directly below a screenshot, identifying the window (and where necessary, the alternative region) that appears in the screenshot. The heading of the navigation path should be identical to the actual name of the window as seen by the user. 

Use the following abbreviations in navigation paths: 

Abbreviation
Definition
B

button

H

hyperlink 

I

icon

M

menu

N

navigator

T

tab

Example:
Invoice Batches Summary
(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve 

This simplified path translates to the following: 

(N) From the Navigator window, select Invoice > Entry > Invoice Batches Summary. 
(M) From the menu bar, select Query > Find.
(B) Click the Approve button. 

Use an angle bracket (>) symbol to create the arrow. Include a space on either side of the angle bracket.

A new heading must follow the navigation path to introduce the first subtopic for the page. 


	 
	notation conventions
(See GUI conventions; typographic conventions)


	 
	notes
(See also cautions; instructor notes; technical notes; warnings)
Use notes to call attention to important information or information that does not flow with the main text (for example, information that applies only in special cases).

Put all information under one note. Do not repeat the note heading. 

Follow the word Note with a colon, and put the word and the colon in bold.

Example:
Note: Each item type has an associated set of properties specific to that type.


	 
	noun strings 
(See compound words and hyphens; 
writing principles)


	 
	nouns as verbs
Do not create verbs from nouns or nouns from verbs. 
Examples:
Refer to the installation guide for more information.
   not
Refer to the install guide for more information. 

Update (or move) your customers to the latest release as soon as possible. 
   not
Transition your customers to the latest release as soon as possible. 


	 
	number agreement 
(See gender; subject-verb agreement) 


	 
	numbers
(See also currency; dates; equations; time) 


	 
	General Guidelines 
In deciding whether to use numbers or to spell them out, keep in mind the nature of the information and strive for consistency. Follow these general guidelines: 
Spell out cardinal numbers from one through nine. Use numbers for 10 and above. 

Examples:
Boston provides five servers.
   not
Boston provides 5 servers. 

The table has 12 rows. 
   not
The table has twelve rows. 

Treat numbers that refer to comparable quantities similarly. For example, if the largest number is presented as a numeral, write numbers from one through nine as numerals.

Example:
Between 8 and 15 people attended the seminar.
   not
Between eight and 15 people attended the seminar.

Spell out any number that begins a sentence, unless the number is a part of a product name.

Example:
Eleven servers are located in Boston.
   not
11 servers are located in Boston.

1-to-1 Fulfillment Features
   not
One-to-One Fulfillment Features

Spell out approximate numbers. 

Example:
Oracle9i is fully portable to nearly ninety distinct hardware and operating system platforms. 
   not
Oracle9i is fully portable to nearly 90 distinct hardware and operating system platforms.

Use numerals with units of measurement. 

Example:
The application requires 8 MB of RAM. 
   not
The application requires eight MB of RAM.

Use from and through to express a range of numbers. 

Example:
The launch procedure is described in this lesson from pages 5 through 10.
  not
The launch procedure is described in this lesson from pages 5 to 10.

Spell out ordinal numbers. Do not add -ly or abbreviate. 

Example:
first, second, third
   not
firstly, secondly, thirdly 
1st, 2nd, 3rd

When one number follows another, spell out the smaller one for ease of reading, or rewrite the sentence so that the numbers are not adjacent.

Examples:
There are eleven 100 MB data files.
   not
There are 11 100 MB data files.

There are 255 eight-MB data files.
  not
There are 255 8 MB data files.
There are two hundred fifty-five 8 MB data files.

Note: In the above example, the rule about numerals with abbreviations may be superseded.

Use a numeral with a symbol. 

Example:
Contention on the server should never be greater than 9%. 
   not
Contention on the server should never be greater than nine %. 

Do not state the word number to identify a numeral in text. 

Example:
Lines 8 through 12 contain comments.
   not
Line numbers 8 through 12 contain comments. 

Use a comma in numerals of more than three digits unless you are referencing a number displayed on the screen that does not use a comma. 

Example:
The customer ordered 2,000 units. 
   not
The customer ordered 2000 units.


	 
	Hyphenation
Hyphenate adjectival compounds consisting of a number and a unit of measurement before the noun. 
Examples:
5-mile limit 
30-pound package
65-year-old employees

Note: Do not hyphenate compounds consisting of a number followed by the word percent or a number followed by an abbreviated unit of measurement. 

Examples:
10 percent profit
2 GB memory

Hyphenate spelled-out fractions used as adjectives. 

Example:
two-thirds majority 


	 
	Spacing
Include a space between a number and its unit of measure. 

Example:
640 Kb
not
640Kb

Do not include a space between a number and a symbol. 

Example:
15%
not
15 %


	 
	Decimals
Include a zero in front of decimal numbers less than 1.0, except in statistics, where correlation coefficients are expressed without the zero. 
Example:
0.95 
 not
.95 


	 
	Fractions
Spell out common fractions. 
Example:
Some employees work half time. 
   not
Some employees work 1/2 time. 

Use numerals for mixed whole numbers and fractions. 

Example:
2 3/4 or 2.75 
   not
two and 3/4 or
two and three-fourths 


	 
	O 


	 
	objectives lists 
(See lists)


	 
	on and about 
(See about, of, and on) 


	 
	on and in
(See prepositions)


	 
	once
Do not use once when you mean when or after. 

Examples:
When you escalate a service request, Oracle Workflow processes and delivers the notifications regarding escalation activity. 
  not
Once you escalate a service request, Oracle Workflow processes and delivers the notifications regarding escalation activity.

After you click Upload, use the Browse functionality to locate the files that you want to upload to Oracle Files Online. 
  not
Once you click Upload, use the Browse functionality to locate the files that you want to upload to Oracle Files Online.


	 
	only 
Place the word only in a sentence nearest the word that it modifies. A common mistake is to place it between the subject and the verb or between the auxiliary verb and the main verb.
Example of subject-verb split:
The manager hired only two engineers.(The implication is that the manager hired no one else.)
   not
The manager only hired two engineers. (The implication is that the manager did nothing else.)

Example of auxiliary and main verb split:
This type of parallelism is applicable only to partitioned tables. (The implication is that the feature does not apply to any type of table other than partitioned tables.)
  not
This type of parallelism is only applicable to partitioned tables.(The implication is that the feature does not have other functions.)


	 
	Oracle Corporation
(See also product names; trademarks)

Use Oracle Corporation or simply Oracle when referring specifically to the company. Because the term Oracle is trademarked, use it as a proper adjective modifying a noun in all instances other than the company name. The company name is also the only instance of Oracle where the possessive form is allowed.
Do not personify the term Oracle in phrases such as “Oracle suggests ...” or “Oracle recommends ....”

Example:
You may want to set up a Pay Group specifically for EDI payments. 
   or
It is suggested that you set up a Pay Group specifically for EDI payments. 
   not
Oracle suggests that you set up a Pay Group specifically for EDI payments.


	 
	Oracle server 
(See also release and version)
The following table contains guidelines pertaining to the Oracle server.

Term

Comment

Oracle server

The Oracle server, or RDBMS, is the system that manages the customer’s database.

Oracle8 Server

When information is specific to version 8, specify the product name as Oracle8. Do not specify the release unless it is necessary.

Oracle9i Server

The i is italic and Times New Roman.




	 
	over and more than
Use over to refer to a position or location above something. Use more than to refer to quantities. 
Examples:
Towering over the competition, the company exceeded expectations. 
The company sold more than 10 million shares in the first few minutes of trading. 
   not
The company sold over 10 million shares in the first few minutes of trading. 


	 
	P 


	 
	parentheses
(See also brackets)

Parentheses, like commas and dashes, set off amplifying, explanatory, or digressive elements in a sentence. If such parenthetical elements retain a close logical relation to the rest of the sentence, use commas. If the logical relation is more remote, use dashes or parentheses. 
Example:
Use acronyms (words formed from the initial letters of a name) sparingly. 

Do not put parentheses inside parentheses. Use brackets instead. 

Example:
Call the Help Line ([408] 555-1212) for assistance.

Note: This convention differs from mathematical notation, where nesting in equations follows the order {[( )]}.


	 
	passive verbs 
(See verbs: Active Verbs) 


	 
	percent and percentage 
Use percent with a specific number; otherwise use percentage. 

Examples:
a forty-percent increase 
the cache hit percentage 
CPU resources are distributed by specified percentages.
The sum of percentages at any given level must be less than or equal to 100. 


	 
	personification 
(See also allow, enable, let, and help)

Generally, do not use terms that give human characteristics to inanimate objects such as the parts of your course or the components of an application. Note that many instances of personification can be avoided by phrasing sentences so that the user performs the action.

Examples:
Enter a username and password in the Configure ID dialog box.
  not
The Configure ID dialog box asks you to enter a username and password.

The "Select Methods" lesson covers the various ways that you can display data in a document.
  not
The "Select Methods" lesson teaches you the various ways that you can display data in a document.


	 
	plurals 
Use an s to form the plurals of words used as words, letters, and numbers. 
Note: Do not italicize the s.
Examples:
Remove one of the thes in this sentence. 
There are two ms in accommodate. 
Bits consist of 0s and 1s.

Form the plural of abbreviations and acronyms by adding a lowercase s to the uppercase letters. 

Example:
URLs
   not
URL’s 

Do not use (s) to show singular and plural. The plural form implies the singular. 

Example:
This section shows you how to initialize your hard disks. 
   not
This section shows you how to initialize your hard disk(s).

Note: In OCP exams and some quizzes, it is acceptable to use (s) to indicate the possibility of a correct singular or plural response.


	 
	possessives 
(See apostrophes)


	 
	prefixes
(See also compound words and hyphens; suffixes)
The following guidelines are not exhaustive. For more information, see a dictionary or The Chicago Manual of Style.
Nearly all compounds formed with the following prefixes are closed (that is, unhyphenated), whether they are nouns, verbs, adjectives, or adverbs: 

ante

co

hyper

macro

multi

pre

semi

trans

anti

counter

hypo

meta

neo

pro

socio

ultra

auto

de

infra

micro

non

proto

sub

un 

bi

equi 

inter

mid

over 

pseudo

super

under 

bio

ex

intra

mini 

post

re 

supra 

 

Note the following exceptions to the preceding guideline: 

Capitalized words or numerals: Hyphenate most compounds in which the second element is a capitalized word or a numeral. 

Examples:
mid-August 
pre-1990 

More than one word: Hyphenate compounds in which the second element consists of more than one word. When a prefix is added to an open compound, the hyphen becomes an en dash.

Examples:
non-thread-safe (not nonthread-safe)
pre–Gulf War (not pre-Gulf War)

Prefix standing alone: When alternative prefixes are offered for one word, hyphenate the prefix standing alone. 

Examples:
over- and underused 
pre- and posttest 

Repeated vowels: Most compounds with repeated vowels are spelled without the hyphen. 

Examples:
cooperate, coordinate
preeminent, preempt
reenter, reexamine

When the last letter of the prefix and the first letter of the root word are the same, consult Merriam-Webster’s Collegiate Dictionary, 10th ed., for the preferred spelling. Hyphenate compound words not found in the dictionary only if a closed compound is awkward or confusing.

Examples:
non-null
semi-independent 

Hyphenate words formed with the following combination forms: 

all (all-around, all-inclusive) 
cross (cross-referenced) 
ex (ex-applicant, ex-employee) 
half (half-dollar, half-time) 
self (self-addressed, self-assured) 


	 
	prepositions (See also about, of, and on; above and below; because of and due to; by)
A preposition establishes a relationship such as space, time, accompaniment, cause, or manner between its object and another word in the sentence. 
A preposition always has an object, which is usually a noun or a pronoun. 

Examples:
after class 
because of insufficient funds 
between us 

Capitalize prepositions of five or more letters in titles and headings. Do not capitalize prepositions of four or fewer letters in titles and headings unless they occur at the beginning or end of the title or heading.

Examples:
Learning About Your New Computer
About Rebooting Your New Machine
Looking for New Features 
What to Look For 

Words used as prepositions include the following: 

about

around

beyond

inside

outside

under

above

at

by

into

over

underneath

across

before

down

near

past

until

after

behind

during

of

since

unto

against

below

except

off

through

up

along

beneath

for

on

throughout

with

amid

beside

from

onto

to

within

among

between

in 

out

toward

without

Replace wordy prepositional phrases with shorter ones. (See also redundant or wordy phrases)

Example:
before 
not
prior to

Follow these examples for using the prepositions in and on.

Examples:
in the Clipboard
in a dialog box 
in a report 
in a slide 
in a window
in a form 
on the interface
on a menu
on the network
on the screen
on a tabbed page 
on the toolbar 


	 
	press
(See also click and double-click; select and choose)
You press the mouse button. You do not click or click on the mouse button.

You press a key on the keyboard. You do not depress, hit, or strike a key on the keyboard.

Examples:
Enter the number and press [Return].
Press the mouse button to select a menu command.

Note: In most technical writing, however, use the terms click or right-click to refer to the specific GUI element that is the object of interaction with the mouse. A better construction in the example above is "Click the menu command."


	 
	procedures
A procedure is a collection of related steps that the user performs to complete a task or activity, such as entering all of the information required in a window. A step is an action that the user performs as part of completing the task. A step usually describes only one action, such as selecting Open from the File menu. A step may also describe an action that the user performs more than once, such as entering information in several fields. 
To write a procedure, follow these guidelines:

Use the "how to" style of heading for procedural steps.

Example:
How to Install a New Server
Use a numbered list to indicate each step in a procedure.

Try to limit the number of steps in a procedure; the ideal length is between three and nine steps. If the procedure contains more than 10 steps, consider breaking it into two procedures. If the procedure contains only one step, simply start it on a separate line.

To describe options, use second-level bullets under a step. 

Generally, start each step with a verb that describes what action the user is to take.

Generally, limit each step to one action. It is acceptable to combine two actions into one step if both actions are short and simple.

If necessary, follow the step with an explanation or a description of the result of the action. Place this information in a second paragraph immediately following the action to which it pertains. Do not number these explanatory paragraphs. Resume numbering with the next step.

Try to avoid conditional statements. If it is necessary to introduce a step with if, then use a go to statement to specify the number of the next applicable step (unless the user goes directly to the next step in the sequence).

Do not give the user a preview of the action that you are about describe. 

Example:
1. Click Install. The Install dialog box opens. 
2. Click New to specify that you want to install a new server.
   not
1. Click Install. The Install dialog box opens in which you will specify that you want to install a new server. 
2. Click New. 

Refer to GUI elements in a procedure list with the same terms that appear in the graphics that accompany the procedure.

It is acceptable to have an introductory sentence or two between the heading and the step list. If the introductory material is several sentences long, or more than one lengthy paragraph, give it a separate heading.

Example one:
How to Specify Site Uses and Telephone Numbers 
1. Select one or more of the following check boxes to enable the site for defined purchasing activities. 
– Pay Site is the site to which you send payment for goods or services. 
– Purchasing Site is the site from which you order goods or services.
– RFQ Only Site is the supplier site to which you send only a request for quotation.

Note: The Purchasing Site and RFQ Only Site check boxes must be selected to facilitate the use of this supplier site for RFQs only.

2. Enter the supplier site telephone number, fax number, and e-mail address.

3. Save your work. 

Example two:
How to Enter Supplier Data
Supplier information is a vital part of Oracle U.S. Federal Purchasing that is used in all components of procurements, from the requisition request through the payment for goods or services rendered. 
1. Enter the name of the site in the Name field. Remember to use the correct naming convention. 

2. Select the country code from the list of values in the Country field. If the country that you select has a flexible address style assigned to it, the flexfield window opens, in which you can enter an address in the format associated with that country.

3. Enter the address, including city, state, postal code, province, and county as applicable.

(Note: If the student is looking at the screenshot, specifying the name of the field is optional. For example, it is not necessary to say, "Enter address, including city, state, postal code, province, and county, in the appropriate fields in the SupplierSite region." This is also true in steps 1 and 2; because there is only one Name field in the window, it is acceptable to say simply, "Enter the name of the site.") 

4. If you want to prevent an invoice or a purchase-order entry for this site after a certain date, enter a date in the Inactive On field. Otherwise, proceed to step 7.

Example three:
How to Perform a Find All Query
1. In the Suppliers Summary window, select 
Query > Find All. The entire supplier database is displayed in alphabetical order.

2. Select the supplier that you want and then click Open. The Suppliers window opens with the supplier’s information. 

Note: You can select Clear Form from the toolbar to clear the form and discontinue this search. 


	 
	product names 
(See also Oracle Corporation; trademarks)
Do not repeat product names excessively. 
You can use a shortened name for the product, such as the Generator instead of Oracle Forms Generator.

Note: Put the shortened version of a product name in parentheses immediately following the official name at its first mention in a course. This satisfies trademark regulations

For more specific information about product names, see the Oracle Legal Web site at http://doctools.us.oracle.com/trademarks.html. 


	 
	pronouns (See gender) 


	 
	punctuation
The following punctuation marks are discussed in this guide:

angle brackets
apostrophes
brackets
colons
commas
dashes
ellipses
exclamation marks
hyphens (see also compound words and hyphens)
parentheses
question marks
quotation marks
semicolons
slashes
Note that commas, colons, and semicolons are set in the type style of the preceding word. Set periods, quotation marks, question marks, and parentheses in the type style of the surrounding text.

Do not add a space before a punctuation mark.


	 
	Q 


	 
	question marks
Use a question mark at the end of a sentence that poses a direct question. Do not use this mark at the end of a sentence if the question is indirect.
Example of direct question:
What is the system administrator’s password?

Example of indirect question:
Ask the system administrator what her password is.

Place a question mark inside quotation marks or parentheses only if it is a part of the quoted or parenthetical text.

Examples:
What is the system administrator’s password (if you know it)?
The manager asks, “What is your self-appraisal form?”

If a declarative sentence (a statement) and an interrogative (a question) end at the same time, keep the question mark and omit the period.

Example:
When you enter the complex, the help desk representative asks, “What is your employee number?” 


	 
	quotation marks 
In hyperlinks
To reference Help text, enclose the topic name in quotation marks.
Example:
In online Help, click the “Data diagram elements and notation” link.


	 
	In Phrases
Code
In direct computer input or output—that is, material that is set in Courier New—place any punctuation that is not part of the code outside quotation marks. In code, the quotation marks should be straight (' '). You can obtain straight quotes in Word and PowerPoint by navigating to Insert > Symbol and then selecting the single and double straight quotation marks.

Text
Follow these general guidelines for regular text:

Place periods and commas inside quotation marks that follow phrases, single words, or quoted passages of text.

Examples:
For more information, see the lesson titled “Introduction.”
   not
For more information, see the lesson titled “Introduction”. 

See the next section, “Building Menu Modules,” for more information. 
   not
See the next section, “Building Menu Modules”, for more information.

Note: Generally, all other punctuation falls outside quotation marks, except in direct quotations. (See also American and British usage) 

Place single quotation marks inside double quotation marks. 

Example:
The instructor said, “I’m here to describe the concept of ‘object-oriented’ technology.” 

Place short phrases and words in quotation marks if you need to differentiate them from surrounding text. This includes phrases in user interface screens. If the phrases are in caps/lowercase, omit the quotation marks.

Examples:
Select “Include a reusable module component” and click Finish. 
Modify the Record List Template Filename preference at the module level. 

Use curved (“smart”) rather than straight quotation marks in general text. Reserve straight quotation marks (' ' and '' '') for code.


	 
	In Titles
Use quotation marks when you refer to the titles of parts of books and courses. 
Examples:
See the lesson titled “Building Menu Modules” for more information. 
The “Menu Styles” slide describes the kinds of menus. 

Do not use quotation marks in title references if you identify the title with a generic term.

Examples:
See Appendix A for more information. 
   or
See Appendix A, “SQL*Plus Sample Section,” for more information. 
   not
See “Appendix A” for more information.


	 
	R


	 
	redundant or wordy phrases
Avoid using phrases and terms that are redundant or wordy.

Do Not Use

Use

a number of 

several

acute crisis

crisis

add an additional

add

adequate enough

adequate

advanced planning

planning

along the lines of or in the nature of

like

another additional

another or additional

as a result

consequently or therefore

as long as

if

assembled together

assembled

at any given point in time

at a particular time or at any time

at the present time

currently or now

background experience

experience

both alike

alike

check to see

verify

close proximity

near

completely eliminate

eliminate

component part

component or part

connect together

connect

consensus of opinion

consensus

continue on

continue

due to the fact that

due to or because

equally as

equally

few in number

few

for the purpose of

for or to

give consideration

consider

important essentials

essentials

in a number of cases

sometimes

in a satisfactory manner

satisfactorily

in order to or with a view to

to

in the case of or in the event of

if or for

in view of or for the reason that or owing to the fact that

because

is dependent upon

depends on

make a choice

choose

make a decision

decide

make use of

use

mix together

mix

needs to be

must

past history

past or history

preloaded

loaded

preplan

plan

prior to

before

serious danger

danger

should be used or should be required

(is) necessary

spell out in detail

spell out or detail

subsequent to 

after

three different types

three types

through the use of

with

together with

together

to license

license

utilize

use

very unique

unique

vital necessity

vital

with regard to or as to

about or regarding

with the exception of

except

written documentation

documentation




	 
	release and version
(See also Oracle server)
The convention in the industry is that a version is one number, such as “version 9,” and a release is a revision of a version, such as “release 9.2.” This rule applies to Oracle servers, but Oracle Applications use the term release where version is expected.

Examples:
Oracle9i, release2
Oracle Process Manufacturing, Release 11 

Follow these guidelines regarding releases and versions: 

Do not capitalize release or version except in titles and headings. 

In course titles, do not put the release designation in italic. Note the comma before “Release 11.” 

Example:
Oracle Public Sector Purchasing, Release 11 

Use the expression “release 9i or later,” not higher, better, or above. 

Use the expression “release 9i or earlier,” not lower, below, or previous. 

Abbreviate release only if lack of space requires it.

Example:
release 11
   not
rel. 11 or R11

Note: In some cases, the term Release may be considered part of the product name and, as such, must be capitalized in all occurences.

Example:
Oracle9i Database, Release 2

For more specific information about product names, refer to the Oracle Legal Web site at http://doctools.us.oracle.com/trademarks.html 


	 
	resources for this guide 
Use the following books and documents as references in conjunction with this guide. The editions are current as of the publication date of this guide. 
Primary Resources 
Editorial style: The Chicago Manual of Style, 14th edition

Dictionary: Merriam-Webster's Collegiate Dictionary, 11th edition

Computer dictionaries:IBM Dictionary of Computing (database standards); Microsoft Press Computer Dictionary, 5th ed. (GUI standards)

Instructional design: 

· General: G. Morrison, S. Ross, and J. Kemp. Designing Effective Instruction. 3rd ed. Wiley, 2000. 

· Web standards: J. Nielsen. Designing Web Usability. New Riders Publishing, 2000; W. Horton. Designing Web-Based Training. Wiley, 2000. 

· Basic references for ILT courses: TIPS Vol. 1: Designing Effective Courses; TIPS Vol. 2: Developing Effective Courses 

Format and design: Oracle University Production Services PowerPoint template (current release). You can find current templates at http://globalxchange.oracle.corp.

Supplemental References
Usage books: Marjorie E. Skillin, Robert M. Gay, et al. Words into Type, 3rd ed. Prentice-Hall, 1974; William Strunk Jr. and E. B. White. The Elements of Style, 4th ed. Allyn & Bacon, 2000; Merriam-Webster's Dictionary of English Usage

Style guides: Oracle Style Guide, Release 3.0; The Microsoft Manual of Style for Technical Publications; Read Me First! A Style Guide for the Computer Industry (Sun Microsystems)

Dictionaries: American Heritage Dictionary of the English Language, 3rd edition; Oxford English Dictionary
Course style sheets


	 
	S 


	 
	select and choose
(See also GUI conventions)
Use select to indicate choosing an option, either from a menu or from a choice of option buttons, and marking text for a user action. Use choose only if select becomes repetitive.

Examples:
Select File > Save. 
Select the text and press [Delete]. 
Select Landscape in the Print dialog box. 
Select the Additional Quantity check box. 
Select the appropriate values from the list of values. 
Choose the selected item. 


	 
	semicolons 
(See colons; commas)
Avoid semicolons whenever possible: they often create unnecessary difficulties for translation and are also difficult to read online. When you do use a semicolon, follow these general guidelines.
Do not put a space before the semicolon. 

Use a semicolon to separate items in a series when the items themselves contain commas. This is the only situation in which semicolons are unavoidable.

Example:
Application Foundation displays three fields: Tools, which you use to select an appropriate tool; Username; and Password.

Avoid separating complete sentences with a semicolon, which may be confusing to nonnative speakers of English. If possible, use a period to separate the sentences.

Examples:
Most object-oriented programming languages are versatile and flexible. C++, however, is one of the most powerful.
   not
Most object-oriented programming languages are versatile and flexible; however, C++, is one of the most powerful.

Row Erase clears field values from your terminal. It does not delete them from your database.
   not
Row Erase clears field values from your terminal; it does not delete them from your database.

Use a semicolon to connect the main clauses of a compound sentence if a coordinate conjunction such as and or or does not connect them.

Examples:
Most subqueries start out as stand-alone queries; they are incorporated as subqueries after their results are tested.
  better
Most subqueries start out as stand-alone queries. They are incorporated as subqueries after their results are tested.

Do not use a semicolon before expressions such as for example, that is, for instance, or namely, if they do not introduce an independent clause or sentence. Use parentheses or an em dash instead.

Examples
The development environment has a reporting process that generates an error message if it cannot compile your program (that is, if any type of error occurs in the code).
   not 
The development environment has a reporting process that generates an error message if it cannot compile your program; that is, if any type of error occurs in the code.

You can address a wide spectrum of requirements with portlets that are implemented declaratively—namely, by using wizards.
   not
You can address a wide spectrum of requirements with portlets that are implemented declaratively; namely, by using wizards.

Use an alternative browser (for example, Netscape or Lynx).
   not
Use an alternative browser; for example, Netscape or Lynx.



	 
	serial comma 
(See commas) 


	 
	server
(See also Oracle server) 

Like all nouns, server should begin with a lowercase letter when it is used generically, and with a capital letter only when it is part of a proper name. 

Example:
the Oracle server 
the login server 
Web server 
Oracle Internet Directory server

The following is a list of some of the more common proper names in which Server should be capitalized. 

Examples:
Oracle9i Server (Here, with the version number, it is a product name and not a generic term.)
Oracle9i Application Server 
Oracle HTTP Server 
Oracle Parallel Server 
Oracle Proxy Server
Oracle Text Server 
Oracle WebServer (Note: One word with internal capitalization)

Note: Capitalize Server in these cases even if you do not repeat the word Oracle. 

Example:
HTTP Server


	 
	since 
(See as, because, and since; once)


	 
	slashes
Avoid using a slash in place of a connecting word. This structure can introduce ambiguity, especially for translation. 
Example: 
Referencing and Applying Menu Parameters 
   not
Referencing/Applying Menu Parameters

Example:
Create a custom menu if you need additional or different menu functions from those provided by the default menu.
   not
Create a custom menu if you need additional and/or different menu functions from those provided by the default menu. 

Note: The first sentence implies that it could be “one or the other, or both” conditions. If greater clarity is needed, reword the sentence to say specifically, “one or the other, or both.” 

In cases where you must use a slash, do not use a space to separate the slash from the surrounding words.

In technical documentation, you may need to differentiate between a slash (/) for URLs and a backslash (\) for servers and folders.

Use a slash (rather than a hyphen) for the following standard terms:

· client/server 

· input/output 

· read/write


	 
	spelling

Oracle University course developers should use Merriam-Webster’s Collegiate Dictionary, 10th ed., to resolve spelling issues.

The following spelling issues are discussed in this guide:

· abbreviations and acronyms
· American and British usage
· capitalization
· category names
· GUI conventions
· terminology


	 
	subheadings 
(See headings; titles) 


	 
	subject-verb agreement 
If a subject is singular, the verb must also be singular; if a subject is plural, the verb must be plural. 
Example:
A company’s success, as well as its profits, comes from the ability to stay ahead of its competitors. 
   not
A company’s success, as well as its profits, come from the ability to stay ahead of its competitors. 

A subject consisting of more than one singular noun joined by and requires a plural verb. 

Example:
The casting of the line and the distribution of the matrixes occur automatically. 
   not
The casting of the line and the distribution of the matrixes occurs automatically.

A subject consisting of more than one singular noun joined by or or nor requires a singular verb.

Example:
Either the PC or the terminal is available for use. 
   not
Either the PC or the terminal are available for use.

If a subject is composed of both singular and plural nouns joined by or or nor, the verb must agree with the noun nearest it.

Examples:
Neither skills nor equipment was lacking. 
   not
Neither skills nor equipment were lacking. 

Neither equipment nor skills were lacking. 
   not
Neither equipment nor skills was lacking.

Collective nouns require singular verbs unless you refer to individual members of the group.

Examples:
The class finds (not find) the manuals easy to use.
Some students in the class find (not finds) the manuals difficult to use. 


	 
	subjunctive mood
Use the subjunctive mood sparingly in technical writing, which should be as concrete and specific as possible. The subjunctive mood is used to express hypothetical or conditional situations. In general, use the indicative mood (for information) or the imperative mood (for procedures). 
Example:
You can identify the standard indirect cost component. (indicative) 
   or
Identify the standard indirect cost component. (imperative) 
   not
It is important that you identify the standard indirect cost component. (subjunctive) 


	 
	suffixes
(See also American and British usage )
Avoid overusing or inventing words with suffixes such as -able
Examples:
You can read and write to this file.
   not
The file is readable and writable.

You can download the software quickly and easily.
   not
The software is quickly and easily downloadable.

Generally, do not hyphenate words formed with the following suffixes: 

fold: Close up compounds with the suffix fold unless they are formed with numerals. 

Examples:
multifold
tenfold 
25-fold

like: Generally close up compounds formed with the suffix like. Exceptions, which are hyphenated, include words ending in l or ll, words of three or more syllables, compound words, most proper nouns, and other forms that are difficult to read. 

Examples:
catlike, formlike, gridlike 
gel-like, doll-like 
corporate-like
laser-printer-like 

wide: Close up compounds ending in wide. 

Examples:
countrywide
enterprisewide 
statewide
worldwide 


	 
	T 


	 
	tables
Tables are useful for efficiently showing specific, related facts or statistics in less space. Follow these guidelines when developing tables:

Create tables that logically read across to show the relationships described. Otherwise, the format should be a simple list.

If introductory text precedes the table, make that text relevant to the information in the table.

As a general rule, use descriptors as headings of table columns rather than lead-in phrases.

Example:
Required
Information
Definition
Service name

The name of the Web agent service

Username

The database name used to connect to the database

   not
Required
Information

Defined as . . . 

Service name

The name of the Web agent service

Username

The database name used to connect to the database

Align multiple-line column titles on the bottom line.
Example:
Required
Information
Definition
Service name

The name of the Web agent service

Username

The database name used to connect to the database

not 
Required
Information

Definition

Service name

The name of the Web agent service

Username

The database name used to connect to the database

Align column headings on the left (see preceding examples).
Begin each entry in all the columns of a table with a capital letter.
Use capital and lowercase letters for table titles and column heads.
When a statement in a table row consists of a sentence fragment followed by a full sentence, end the fragment with a period.
Example:
Attribute

Purpose

COMP_PLAN_PERIOD
The compensation plan period that corresponds to the procession period of the source transaction. (Oracle Sales Compensation uses this period.)

When a column in a table contains rows of sentence fragments and rows of full sentences, do not include periods after the fragments but do include periods after the sentences.
Note: Try to develop items in a table in one consistent style: all fragments or all sentences. Then punctuate accordingly: no periods after fragments and periods after full sentences.


	 
	technical notes
(See also instructor notes; notes)
Technical notes clarify or enhance the student's understanding of the subject. The tag for this block label produces “Technical Note,” singular, with no colon following the text. 
Example:
Technical Note
   not
Technical Notes:


	 
	templates
See the following Web site for Oracle Education Products templates and usage guidelines: 
http://globalxchange.oraclecorp.com/


	 
	tense 
(See verbs: Tense) 


	 
	terminology 
(See also GUI conventions; typographic conventions)
When possible, use generic terminology that is familiar to speakers of both American and British English.
Term

Comment

above

Do not use when you mean preceding or previous.
abridgment

Not abridgement
access

Do not use; instead, use start or connect to.

accounting flexfield

Note lowercase. 

acknowledgment

Not acknowledgement
activate

Do not use; use the simpler alternative start.
ADA-compliant

Do not use; use accessible.

adapter

Not adaptor
although, though

Use instead of while unless you specifically mean "during the time that."

analog

Not analogue
and so forth, and so on

Not etc.
ANDed

Do not use.

angle brackets

Not carets or arrows
antedate

Do not use; instead, use predate.
appears 

Do not use; instead, use opens or is displayed.
appendixes

Not appendices
applet

 

applicationwide (n, adj)

 

ARCHIVELOG
Keyword

assembly language (n)
assembly-language (adj)

 

audit trail

Lowercase in generic use

AuditTrail 

An HRMS utility

auto 

Do not use; instead, use automatic.

autosourcing

 

B-tree, B*-tree

Balanced tree; a structure used for storing database indexes
(B*-tree is usually the correct term for Oracle indexes. The term B-tree may apply to other kinds of indexes.)

back end (n)
back-end (adj)

 

backslash

\ (See slashes)

backspace

 

back up (v)
backup (adj, n)

 

Backus-Naur form

 

backward

Not backwards
bean (n, adj)

Lowercase bean is used to refer generically to a JavaBean (for example, in the term bean-managed persistence). In some cases, capitalized Bean may be more correct as the noun form, depending on context and usage.

below

Do not use when the object is not directly below the textual reference. Use as follows or the following.
bill of material (sing.)
bills of material (pl.)

Generic; not the Oracle Bills of Material product

bill of resource

No hyphens

bill-to address

A type of address

bit location table 

 

bitmap, bitmapped

 

Boolean

 

bottom-up (adj)

 

braces

{}; not curly brackets
brackets

[ ]; not square brackets
breadcrumbs

Do not use locator links.

breakpoint

 

bypass

 

by-product

 

bytecode

 

call out (v)
callout (n)

 

cancel (v)

To nullify a selection. Use clear for check boxes.

canceled, canceling

Not cancelled, cancelling. But cancellation.
cannot

One word

catalog

Not catalogue
Cartesian

 

character mode

 

charge back (v)
chargeback (n)

 

check

Do not use to mean select.
check box

Two words

check in (v)
checkin (n, adj)

 

checklist

 

check out (v)
checkout (n, adj)

 

checkpoint

 

checksum

 

clear (v)

Use instead of deselect or uncheck when you mean to cancel the selection of an option button or check box.

click (v)

Not click on. Use for interface buttons, icons, links, and tabs.

client/server

Always use the slash. Do not use client-server.

code name (n)

Not codename
command 

Use instead of menu option or menu item.

command window

 

console

 

control file

Two words

copyedit (v)
copy edit (n)

 

counterclockwise

Not anticlockwise
course material, course notes

Printed course information; not courseware
courseware

Meaning educational software
cross-check (n, v)

 

cross-refer

Do not use; use refer.
cross-reference (n, v)

 

customizable

Not customizeable
cut off (v)
cutoff (n, adj)

 

daemon

 

data

Use with a singular verb (for example, data is). Do not use datum.
database (n, adj)

One word

database browser

Generic usage

data dictionary

 

data file

Two words

data flow

 

data set

 

data sheet

 

data source

 

data store

 

data type

 

data warehouse

 

date stamp (n)
date-stamp (v)

 

daylight saving time

Not daylight savings time

deinstall

Avoid; instead use remove.

deploy (v)

Use only in reference to dissemnating applications on the Web.

descriptive flexfield

Note lowercase.

descriptor

 

deselect

Do not use; instead use cancel the selection.

desktop

 

dialog box

Not dialog or dialogue box
dial-up (adj)

 

dimmed

Do not use; instead, use disabled.
disabled

Do not use dimmed or grayed out.
disk, diskette

Use diskette to distinguish a flexible disk from a hard or rigid disk. 

display

Use as a transitive verb (a verb that takes an object). If necessary, you can use the passive is displayed.

double-click

Always hyphenated. Use for program icons—for example, "To start Forms, double-click the Oracle program icon."

double-sided (adj)

 

down time

Two words

download

 

downside

 

downsize

 

downward

Not downwards
drill down (v)
drilldown (n, adj)

 

drop-down (adj)

 

e-business

 

E-Business Suite

An Oracle product name

eClass

A type of Oracle University course

e-commerce
 

e-form
 

e-mail
 

eMail Center 

A specific product name

embed, embedded

Not imbed, imbedded
embedded table

Do not use; use nested table.
end user (n)
end-user (adj)

 

enquiry

Do not use; use inquiry.
enterprisewide (adj)

 

entity relationship diagram

A type; note lowercase.

Entity Relationship Diagrammer

A function; note caps/lowercase.

equal sign

Not equals sign
equijoin

Not equi-join or equi join
equipartition

 

eStudy

A type of Oracle University course (also called a WBT)

euro

Note lowercase; not Euro or EURO
facility

Do not use when you mean utility.
failover (n, v)

A feature of Oracle Parallel Server

False

The value; not false or FALSE. For example, "The function returns a value of False."

fast path (n)
fast-path (adj)

 

fast track (n)
fast-track (adj)

 

fat client

 

fax

Abbreviation for facsimile; not Fax or FAX
file name

Two words. Spell as one word only when referring to a variable in code instructions and commands.

file type

 

fine-tune (v)

 

floating point (n)
floating-point (adj) 

 

flowchart

 

focused, focusing

Not focussed, focussing
folder

 

form-feed (adj, v)

 

forward

Not forwards
freehand (adj)

 

from...through...

For example, "from page 1 through page 10." Do not use "from...to..." to express a range.

front end (n)
front-end (adj)

 

full-screen (adj)

 

function

 

functionality

 

function hierarchy diagram

A type; note lowercase.

Function Hierarchy Diagrammer

A function; note caps/lowercase.

grayed out

Do not use; instead, use disabled.
grayscale

Not greyscale
-hand

Do not use with direction words. For example, use right column, not righthand column.

handheld device 

Do not use Palm device.

hard-code (v)
hard-coded (adj)
hard-coding (n)

 

hard copy (n)
hard-copy (adj)

 

health care (n)
health-care (adj)

Two words

Help

Capitalize this term when you refer to any Help system. For example "You can get help by using online Help."

hitlist

One word

home page

Two words

host name

Two words

hot line

Two words

hyperlink

 

hypermedia

 

hypertext

 

icon button 

Not iconic button
iconic (adj)

An iconic representation

in-depth (adj)

 

indexes

Not indices
in-house (adj, adv)

 

in-line

The opposite is out-of-line.
input (n)
input (v)

Use only to mean the entering of values and numeric data into a system. Do not use to mean enter.

input/output

 

install (v)

Always a verb. Do not use as a noun; use installation instead. 

instructor

Not facilitator, lecturer, or educator
Internet
internet 

When capitalized, Internet refers to the networks and gateways that use TCP/IP protocols. When lowercase, it is short for internetwork. 

interorganization

Not inter-org
intranet

Note lowercase.

Java

A Sun Microsystems trademark, and as such, should be used only as an adjective (for example, Java technology, Java programming language, Java platform); note caps/lowercase.

JavaBean

One word with internal cap

Java Blend

 

Java Interpreter

 

Java Runtime Environment

 

JavaScript

 

JavaServer Pages

 

Java Servlet

 

Java Virtual Machine

 

JDeveloper

 

JServer

 

judgment

Not judgement
kernel

 

key flexfield

Note lowercase.

keystroke

 

keyword

 

knowledgeable

Not knowledgable
launch

Do not use to mean start.

lay out (v)
layout (n)

 

left-justified (adj)

 

left-most

Do not use. Instead, use left.
life cycle (n)
life-cycle (adj)

 

likewise 

Do not use; instead, use similarly.

line-feed (adj, v)

 

Linux 

Note that UNIX is all capital letters.

list (n)

Not listing; a list of Oracle products

local area network

No hyphens

lockbox (n, adj)

A receivables feature; note lowercase.

lock out (v)
lockout (n)

 

log file

 

log in (v)
login (n, adj)

Log in to an application.

log off (v)

Opposite of log on
log on (v)
logon (n, adj)

Log on to an operating system or machine.

log out (v)

Opposite of log in
log switch

 

look up (v)
lookup (n, adj)

 

manageable

Not managable
many-to-many (adj)
many-to-one (adj)

An attribute

markup (n, adj)

 

master-detail (adj)

For example, master-detail relationship, master-detail budget 

master file

 

master/slave (adj)

Use to describe an arrangement in which one device controls another device; not synonymous with parent/child.
materialized view 

Use instead of snapshot.
matrix, matrixes

Not matrices
menu bar

Two words. Notice that toolbar is one word.

metadata

Data that describes data objects

metamodel

 

migrate

Use only as an intransitive verb (a verb that does not take an object).

modeling

 

mouse devices

Plural of mouse; not mice
multimedia

 

multiple-application mode

Not multi-application or multiapplication
multiple currency

Not multicurrency
multiple organization

Not multi-org or multiorg
multithreaded server

 

multitier

 

multi-user

 

N-tier architecture

 

navigation tree

 

navigator

 

NetBeans

 

NOARCHIVELOG
Keyword

node

 

nonequijoin

 

nonequipartition

 

non-key

Not nonkey
nonnative

 

non-NULL

 

non-thread-safe

 

normal

Do not use when you mean typical or usual.
null, Null, NULL

Use lowercase null to refer to a null value. Use NULL or Null (depending on the language) only to refer to the constant.

object-oriented design

 

object relational database

No hyphens

object technology

 

Off

The value; not off or OFF. For example, "Set the flag to Off."

offline (n, adj, adv)

For example, the printer is offline. Do not use offline as a verb; instead, use take offline.

off-site (adj)

 

OK

Avoid using except when used in a conversational context, or when referring to a GUI element as such.

On

The value; not on or On; for example, "Set the flag to On."

ongoing

 

online (n, adj, adv)

For example, the system is online. Do not use online as a verb; instead use place online.

on-screen (adj)

 

on-site (adj)

 

one-to-many (adj)

 

open source (n, adj)

 

operating system–specific

Use an en dash, not a hyphen

Oracle applications

Use to describe individual application products; for example, Financials applications.

Oracle Applications

The product name

Oracle Corporation
Use when you refer to the company name. In general discussion about the company, Oracle is acceptable. The possesive form, Oracle's, is also acceptable.

ORed

Do not use.

orient, oriented

Not orientate and orientated
outer join

 

output (n, v) 

 

Palm

Do not use. This is a trademarked product name. Instead, use handheld device.

parallelize

Do not use; instead, use make parallel.

parameter file

Preferred to init.ora as the generic term 

parent/child (adj)

Use to describe a hierarchical relationship; not synonymous with master/slave.
part-time (adj)

 

path name

Two words; spell as one word only when referring to a variable in a code example.

PDA

Do not use; instead, use handheld device.

people

Not persons
PFILE

Parameter file; preferred to init.ora as the generic term; not synonymous with SPFILE

plug in (v)
plug-in (adj)

 

poplist

Use pop-up list.
populate

 

pop up (v)
pop-up (n, adj)

Avoid using the verb pop up to refer to a window that opens; instead, use open or is displayed.
postal code

Not ZIP code, zip code, or post code
postbox

Do not use; instead, use mailbox.
PostScript

Note the internal capitalization.

postupgrade

Do not use; instead, use after the upgrade.
PowerPoint

Note the internal capitalization.

practice (n, v)

Not practise. Use practice instead of lab, workshop, or exercise. Do not use "Practice Session" in a title; use "Practice."

pre-(prefix)

Do not use with trademarked names. Use a hyphen before proper nouns that are not trademarked (such as pre-English). Otherwise, do not use a hyphen the prefix pre and the root word.

preceding

Use instead of above. See also previous.
predefined type

Do not use; instead, use built-in type.
preupgrade

Do not use; instead, use before the upgrade.
previous

Use instead of above. See also preceding.
print out (v)
printout (n)

 

pseudocode

 

pseudocolumn

 

pull down (v)
pull-down (n, adj)

Do not use to mean drop-down.

quality

The word quality is neutral. When used as an adjective, it must be modified. Example: a high-quality application

query by example

 

QuickPick or quickpick (v)

Do not use; instead, use list.
quotation marks

Not quotations or quotes
radio button

Do not use; instead, use option button.
read-only (adj)

 

read/write

Not read-write
real time (n)
real-time (adj)

Examples: real-time events; events occur in real time.
reboot

Do not use; instead use restart.

re-create (v)

To mean "create again"; not recreate, which means "to take recreation or to refresh"

reengineer

No hyphen

reentry

No hyphen

reexecute

No hyphen

report

Lowercase generic uses; capitalize specific uses: Account Report.

right-justified (adj)

 

roll back (v)
rollback (n, adj)

 

roll up (v)
rollup (n, adj)

 

row ID 

 

ROWID
A data type

rubber-band (v)

GUI term

run through (v)
run-through (n, adj)

 

run time (n)
run-time (adj)

Two words; except Runtime Library, Runtime Engine

salable

Not saleable
sales representative

Not salesmen, salespeople, or salespersons
savepoint

 

scalable

Not scaleable
screen dump

Do no use; use screenshot.
screen pop

A CRM-specific term in which pop refers to populate, meaning that information in a form appears automatically

screenshot

Not screengrab
scroll bar

 

self-join

Always hyphenated

server name

Two words

server (-side) parameter file

 

servlet

 

sessionwide (n, adj)

 

set of books

Plural is sets of books. Abbreviate as SOB if necessary only on slides, not in text.

set up (v)
setup (n, adj)

 

shelf life

Two words

ship-to address

Reference to a type of address

Ship To field

Reference to a specific field

shut down (v)
shutdown (n, adj)

 

sign off (v)
sign-off (n, adj)

 

sign on (v)
sign-on (n, adj)

 

single-sided (adj)

 

single sign-on

Do not confuse with the product Oracle Single Sign On.

single-user (adj)

 

sizable

Not sizeable
slash

/; not forward slash (See slashes.) Note: In some contexts you may need to differentiate between forward slashes and backslashes.

slide

Not transparency, overhead, or foil
slide show (n)
slide-show (adj)

Two words

slow down (v)
slowdown (n)

 

soft copy

 

spell-check (v)

Do not use; instead, use check spelling.

spelling checker (n, adj)

Not spell check
SPFILE

Not synonymous with PFILE

SQL:1999 standard

Note: Do not insert a space after the colon.

SQL for Java

 

stand-alone (adj)

Not standalone; except Standalone mode
start up (v)
startup (n, adj)

 

status bar

Two words; note that toolbar is one word.

step-by-step (adj)

A step-by-step process is performed step by step.

student

Not attendee, delegate, or participant
style bar

Two words; note that toolbar is one word.

sub-block

 

subclass (n)

Do not use as a verb.

system identifier

 

systemwide (n, adj)

 

table name 

Two words

tablespace

one word

tap

Use instead of click to describe how users physically interact with a touch screen GUI, including handheld devices. 

text file

 

thick client

 

thin client

 

although, though, whereas

Use instead of while unless you specifically mean "during the time that."

through

Not thru
throughput

Not thruput
tick mark

Do not use; use check mark.
timeout (n)

 

time-phased (adj)

 

timescale

 

time sharing

 

time sheet

 

time stamp (n)
time-stamp (v)

 

time zone

Two words

toolbar

One word; note that menu bar and status bar are each two words.

toolbox

 

tooldriver

 

toolkit

 

toolset

 

tool tip

 

top-down (adj)

 

top-most

Do not use. Instead, use top.
touch screen 

Two words

toward

Not towards
traveled, traveling

Not travelled, travelling
tree

 

True 

The value; not true or TRUE; for example, “The function returns a value of False.”

Trusted Oracle

This is a trademarked name.

turnaround (adj)

Example: turnaround time

typical

Use instead of normal. See also usual.
uninstall

Avoid; instead use remove.

UNIX

All capital letters

unmistakable

Not unmistakeable
updatable

Not updateable
up-to-date (adj)

Always hypenated, even as predicate adjective. For example, "This equipment is up-to-date."

upward

Not upwards
usable, usability

Not useable, useability
user-defined (adj)

 

user-friendly (adj)

 

username

One word

usual

Use instead of normal. See also typical.
utilize

Do not use; instead, use the simpler word use.
viewlet

 

voice mail

Two words

wand

The styluslike object used with a touch screen or handheld device

want

Use instead of wish.
Web, the

Shortened version of the World Wide Web

Web agent

 

Web browser

Web Browser 

An Oracle product

Web cartridge

 

Web client

 

Web connector

 

Web listener

 

Web Listener

A component of an Oracle product 

Web page

Two words

Web server

 

WebServer

A component of an Oracle product; note one word

Web site

Two words

what-if analysis

 

while

Use to mean happening concurrently.

wildcard

 

wish

Do not use when you mean want.
wizard

Lowercase when generic; capitalize when used as a component name (for example, the Layout Wizard).

wordwrap

 

workaround

 

workbench

 

workflow

 

workforce

 

workgroup

 

workload

 

workspace

 

workstation

 

World Wide Web (WWW)

The Web. The generic spelling of worldwide is solid.

worldwide

But World Wide Web
wraparound

 

writable

Not writeable
write-only

 

x-axis

 

X Windows

 

y-axis

 

zero, zeros

Not zeroes
zip file

 

 


	 
	that
Although it is often omitted in English, use the relative pronoun that to facilitate translation into languages in which that is not implicit. 
Example:
Select the program that you want to use. 
   not
Select the program you want to use


	 
	that and which
To determine whether to use that or which, follow these two rules:
Use that to introduce a restrictive clause. 
Example:
These parameters contain additional information about the event that generated the message. (The italicized clause is restrictive.) 
   not
These parameters contain additional information about the event which generated the message. 

Use which to introduce a nonrestrictive clause. A nonrestrictive clause is simply a clause that can be removed without changing the basic meaning of the sentence. Always put a comma before a clause that begins with which. 

Example:
These parameters, which contain additional information about the event that generated the message, are required. (The italicized clause is nonrestrictive.) 


	 
	time
(See also numbers)
For exact time, use numerals including a.m. or p.m. (note the lowercase). 
Example:
Begin the backup at 2:00 a.m.

Use words to express an approximate time. Use this only in informal narratives, such as case studies.

Example:
about two o’clock


	 
	titles
(See also headings)
Use the following guidelines for developing titles in a course.
Keep titles short. Do not repeat the title of the course or the name of the product in titles and headings. The course title, which usually includes the product name, appears at the bottom of every page in printed documents, and at the top of the browser in most online material. Course titles should not exceed 60 characters, including spaces, in length.

Titles should contain substantive information. It is especially important that you use substantive titles to provide context for online material, where students may navigate among multiple Web pages in a nonlinear manner.

Examples:
Introduction to Oracle Internet Directory
  not
Introduction

Setup Step 2: Verifying the System Requirements
  not
Requirement Verification

Generally, do not use the imperative mood (the command form of the verb) in titles.

Examples:
Navigating the Designer (task-oriented title or heading)
or
Navigation of the Designer (information-oriented title or heading)
  not
Navigate the Designer

Note: Some product groups may structure course titles in the imperative form.

For some course content, it may be appropriate to structure titles and headings as questions; however, to avoid a repetitive string of questions, do not phrase every title and heading in the interrogative form.

Keep titles to one line. If you must have multiple-line titles, divide the lines in logical places. If possible, do not end a line with an article, conjunction, or preposition. 

Examples:
Compound Words
and Hyphens
  not
Compound Words and
Hyphens

Use the gerund form (a verb ending in -ing) to express action. 

Examples:
Navigating the Designer 
  not
How to Navigate the Designer 
or
Navigate the Designer 
or
Navigation of the Designer

Use the noun form to express conceptual rather than task information. 

Examples:
Windowing Systems
Introduction to Windowing Systems 
Overview of Windowing Systems
About Windowing Systems 

Units
Use informational (conceptual) rather than task-oriented titles. In general, do not use the gerund form in unit titles. 
Examples:
Customers 
User Interfaces 
Introduction to Data Manipulation 
Manipulation of Data with SQL*Plus 

Practices
Use the gerund form. 

Examples:
Practice: Navigating the Designer
Practice: Building Reports with SQL*Plus 


	 
	Headings and Subheadings
A heading, in the Notes section of a PowerPoint page or under the title of a Web page, introduces a topic subordinate to the major topic under which it falls. Headings can appear anywhere on the page. In printed documents, headings are continued on following pages, with the word (continued) in parentheses.

Each page in a printed document must begin with a heading, either directly beneath the slide or, if there is no slide, at the top of the page. Headings on Web pages are optional, and should not be used if they are redundant with the page title.

A subheading introduces a subtopic under the heading’s topic. If this subtopic continues to another page, the subheading should be continued as well, followed by the word (continued) in parentheses. Most subheadings should not continue to the next page, however, because the subtopic they introduce should be brief. If a course has too many continued subheadings, divide the information into additional topics.
Label a section of text based on its function.

Under a slide titled “Installation,” or on a Web page titled “Installation,” you might have the following headings:
Examples:
Server Installation
   and
User Installation

Generally, reserve the “how to” style of heading for procedural steps only. 

Example:
How to Create an Individual Menu
1. In the Main menu, choose the parent item.
2. Add a new item to the menu.
3. Enter a new label to replace the default label.
   not
Steps to Create an Individual Menu
   or
Creating an Individual Menu


	 
	trademarks
(See also Oracle Corporation)
To ask specific questions about trademarks or to obtain new versions of the Oracle trademark list, send a request to:
trademar@us.oracle.com 
To obtain further information about trademarks, visit the online trademark list at:
http://doctools.us.oracle.com/trademarks.html.

or the Trademark page on the Oracle GlobalXchange Web site at:
http://legal.us.oracle.com
To maintain the value of Oracle trademarks, follow these guidelines:

When you refer to Oracle products, use the term Oracle only as an adjective. Do not use Oracle as a noun except when referring specifically to the company.

Example:
Using the Oracle database, you can serve a great number of users. 
   not
Using Oracle, you can serve a great number of users. 

Do not use plural or possessive forms of Oracle product names.

Examples:
Oracle Designer 
   not
Oracle Designers

Designer features or features of Oracle Designer
   not
Oracle Designer’s features 

Do not include trademark symbols in text. The trademarked logo and the notices on the copyright page suffice.


	 
	transitive verbs 
(See verbs: Intransitive and Transitive Verbs) 


	 
	translation, writing for 
(See also terminology; writing principles)
Most Oracle University courses and publications are translated into several languages. Develop courses with this in mind, striving for accuracy, clarity, consistency, and cultural neutrality.

Course materials that are easy to translate provide substantial cost savings to Oracle. For more information about translation at Oracle, see the Worldwide Product Translation Group (WPTG) Web site at: 
http://iewptgweb.ie.oracle.com:8887/
Use clear, concise English and minimize verbiage.

If students find your writing confusing or ambiguous, translation machines and human translators will too. The result will be inaccurately translated documentation and collateral that inhibit usability, impede learning, and reflect negatively on the quality of the product.

Do not use a conversational style, which may read well in English but might not translate well. 

Note: For some Web content, informal conversational language may be appropriate.

Do not use idioms, because they are difficult to translate and usually specific to a single culture. 

Examples:
cover all the bases
over-the-hill
soup-to-nuts
throw in the towel 
reach the finish line 
create from scratch 

Use the relative pronoun that to clarify the independent and dependent clauses in a sentence. 

Examples:
Course developers use the procedural documents that the instructional design team created. 
   not
Course developers use the procedural documents the instructional design team created.


Use then with if constructions to clarify meaning.

Examples:
If you do not have ViewletBuilder on your desktop, then you can download it from the intranet. 
   not
If you do not have ViewletBuilder on your desktop, you can download it from the intranet.

Use consistent terminology. Do not use the same term to mean different things in different contexts, and do not use different terms to describe the same thing. For a current multilanguage glossary produced by the Worldwide Product Translation Group, see:
http://iewptgweb.ie.oracle.com:8000/
iglossary/ui/Home.uix
Avoid humor in technical writing.

Most humor is specific to a language or culture. Do not use humor in technical publications, because it will probably not translate well, if at all. 

Choose examples carefully.

-Do not use country-specific examples.

If you want a scenario to illustrate a point, choose one that is universally recognized. For example, most people are familiar with hotels and transportation, but they may not be familiar with baseball games (U.S., Japan) or car boot sales (U.K.).

-Do not use examples that may be offensive in certain countries, such as examples that involve animals and colors. 

Avoid depictions of and references to human figures and hand gestures.

When writing scenarios, remember that etiquette, level of expected formality, and traditional gender roles may be very different in other cultures.


	 
	typographic conventions
(See also GUI conventions; Backus-Naur form; navigation paths)
Typographic conventions distinguish certain elements (such as file names, key sequences, and commands) from basic text. The following table shows the typographic conventions used in course material. Where Courier New is not specified as the font, Times New Roman is the default typeface for print publications and Arial is the default typeface for Web content. Although not described in this table, code may also be expressed in Backus-Naur form. 

Note:
For programming elements, this table covers primarily SQL and PL/SQL. For other languages, such as Java, use Courier New font and follow the conventions of the language. (See Java typographic conventions)

In theory, commands and syntax in SQL are not case sensitive. However, it is best practice for technical publications to use consistent uppercase or lowercase conventions for particular code elements. Data is case sensitive in SQL and must be entered in the case specified by the DBA. For the purposes of Oracle University courses, follow the recommended guidelines in this chart: 

Element
Typographic Style
Example
arguments

Lowercase Courier New

commit_mode argument

attributes

Uppercase Courier New

%TYPE attribute

block names

Caps/lowercase

Skill Requirements block

blocks

Uppercase Courier New

DECLARE
BEGIN
EXCEPTION
END 

book titles

Caps/lowercase, italic

Oracle8i: Database Administration
built-ins

Lowercase Courier New

Use the enter_query built-in.

button names

Caps/lowercase

Click Cancel.

chapter titles

Quotation marks

Chapter 2, "Building Forms."

clauses

Uppercase Courier New

Restrict the rows selected using a WHERE clause.

code output

Courier New

This statement is displayed
debug.seti('I',300) 
column names

Courier New, lowercase preferred

Employee last names are stored in the last_name column.

commands

Courier New, uppercase preferred

Use the SELECT command to view information.

controls

Uppercase Courier New

IF, THEN, ELSE, ELSIF, EXIT, GOTO
course titles

Italic

Introduction to Oracle
data types

Uppercase Courier New

Data stored in the first_name column in VARCHAR2 data.

database names

Case sensitive

Connect to the Prod database.

directory names

Case-sensitive Courier New, depending on the operating system

bin
My_data
$FMHOME
emphasized text

Italic for print publications; bold for Web content

Do not click Cancel.

events

Caps/lowercase

The trigger fires on the Leave Record event.

field names

Caps/lowercase

Format field; Link File field

file names

Case-sensitive Courier New, depending on the operating system

Initialization parameters are stored in the init.ora file on PCs and in the INIT.ORA file on UNIX machines.

folder

Plain text font 

Drill down to the Library folder.

function names

Uppercase Courier New

Use the SUM function to select the total of all salaries from the s_emp table.

glossary words

Italic, bold

The algorithm inserts the new key.

graphics labels

Initial cap (if the term is a proper noun, use caps/lowercase)

Selected rows
Oracle Payables

icon names

Caps/lowercase

Supplier Option icon

identifiers

Lowercase Courier New

part_no NUMBER(4);
key combinations

Plus signs

Press and hold simultaneously:
[Ctrl] + [Alt] + [Delete]

key names

Brackets

Press [Enter].

key sequences

Commas

Press and release one at a time:
[Alt] + [F] + [D]

keywords

Uppercase Courier New

SELECT
lesson titles

Quotation marks

Lesson 3, "Working with Objects"

links

Caps/lowercase for links referred to in text; underline active links.

Click the Show Me More link.
Show Me More
machine names

Lowercase Courier New

Log on to edsun9
manual titles

Caps/lowercase, italic

Oracle8 Server SQL Reference Manual
materialized views

Lowercase Courier New

Create a materialized view, mview, that displays the manager ID, job, and total salary for each manager.

menu command names

Caps/lowercase

Paste command

menu names

Caps/lowercase

Print menu

menu paths

Greater-than symbol

Select File > Save from the menu bar.

mode names

Uppercase Courier New

Enter NOARCHIVELOG mode

modules

Caps/lowercase

Depot Repair module

objects

Lowercase Courier New 

(OG_GET_LAYER
   (prod_layer')) 
operators

Uppercase Courier New

Use the BETWEEN operator to specify a range of dates.

packages

Lowercase Courier New

PACKAGE emp_action IS 
parameter values

Context-sensitive Courier New

Set the USED_STORED_OUTLINES parameter to TRUE or to a category name.

parameters

Uppercase Courier New

Set the PARALLEL SERVER parameter to Off.

passwords

Case-sensitive Courier New, depending on the operating system

. . . with password as tiger
. . . with password as #wvQ37%
path names

Case-sensitive Courier New, depending on the operating system

Open c:\my_docs\projects first.

phases

Caps/lowercase

Clear phase; Populate phase

procedures

Lowercase Courier New

show_error_alert procedure

profile options

Caps/lowercase; no space after the colon

OE:Item Validation Organization profile

programs

Caps/lowercase

Update Shipping Information concurrent program

properties

Caps/lowercase

Navigable item property

property group names

Caps/lowercase

Menu Module property group; Item property group

reserved words

Uppercase Courier New

ELSIF
schema names

Lowercase Courier New

Drop the tables in the scott schema.

screen names

Caps/lowercase

Maintain Skill Types screen

script names

Case-sensitive Courier New

demo.sql
settings

Caps/lowercase

Deferred with Auto-Query; Immediate

synonyms

Lowercase Courier New

Create a synonym, dep, for the departments table.

syntax

Case-sensitive Courier New

The syntax for defining a record is IS RECORD OF.

system identifiers (SIDs)

Uppercase Courier New 

By default the system identifier is ORCL.
table names

Courier New, lowercase preferred

Information about customer orders is stored in the orders table. 

tablespace names

Courier New, uppercase preferred

TABLESPACE_NAME
trigger categories

Lowercase 

mouse event triggers; commit triggers

triggers

Caps/lowercase Courier New, hyphenated

Assign a When-Validate-Item trigger.

uniform resource locators (URLs)

Lowercase plain text 

http://oracle.com

user input

Courier New

Enter 300.

usernames

Lowercase Courier New

Log on as scott.

values

Caps/lowercase

The function returns a value of False.

variables:
  placeholder


  PL/SQL


  syntax


  system


Case-sensitive, italic, Courier New


Lowercase Courier New


Lowercase, italic, Courier New


Lowercase Courier New


Enter user_id@us.oracle.com, where user_id is the name of the user. 

Declare the bonus PL/SQL variable as 15% of each employee's salary.

where: role is the name of the role to be created

the get_block_property system variable

view names

Lowercase Courier New

my_view
window names

Caps/lowercase

Mail window




	 
	U 


	 
	uppercase letters 
(See capitalization) 


	 
	URLs
Set uniform resource locators (URLs) in plain text font with no internal spaces. 

Example: http://www.oracle.com

Follow the site’s style for capitalization and separators (~, -, _, ., /, \, and |).

Set long URLs on a separate line. If the URL is longer than one line, divide the URL after a slash. Do not divide at a hyphen. 

Example:
http://www.cc.gatech.edu/gvu/user_surveys/
survey-09-1994/html-paper/
survey_2_paper.html#results
   not
http://www.cc.gatech.edu/gvu/user_surveys/survey-09-1994/html- paper/survey_2_paper.html#results

If a URL ends a sentence, add the requisite period. 


	 
	use and utilize
Do not use utilize when you mean use. 
Example:
Use budget formulas to calculate your budget amounts.
   not
Utilize budget formulas to calculate you budget amounts.


	 
	V 


	 
	verbs 
Active and Passive Verbs
In describing an action, use active verbs rather than passive or auxiliary verbs, such as is, are, was, and were. 
Examples:
In this section, you learn about menu modules. 
   not
This section is an explanation of menu modules.
Menu modules are explained in this section.

Follow these steps to connect to the database.
The user follows these steps to connect to the database.
   not
The following steps are carried out to connect to the database. 

Oracle Purchasing collects statistics on critical vendor performance. 
   not
Oracle Purchasing has statistics on critical vendor performance. 

Use a passive verb when the focus of the sentence is on the receiver of the action rather than on the doer, or when the person performing the action is unknown or not important.

Example:
This manual was written for system administrators. 


Intransitive and Transitive Verbs
A transitive verb is a verb that requires an object, such as give or read. An intransitive verb is a verb that does not require an object, such as appear or crash. Be careful not to use a transitive verb as an intransitive verb. 
Example:
When you click Search, a dialog box is displayed (or appears).
The values are returned when the request ends (or is completed).
The transaction is committed.
After the software is installed, you must run the Setup Wizard. 
   not
When you click Search, a dialog box displays.
The values are returned when the request completes.
The transaction commits.
After the software installs, you must run the Setup Wizard.

Tense
Use present tense to describe actions that are ongoing or things that happen as the result of a user action. Do not use past or future tense unless you are referring to actual past or future events. 

Example:
If you do not catalog individual issues in the Main Details screen, you cannot order serials.
   not
If you did not catalog individual issues in the Main Details screen, you will not be able to order serials.


	 
	verbs as nouns
(See nouns as verbs) 


	 
	version and release
(See Oracle server; release and version)


	 
	W 


	 
	warnings
(See also cautions; notes)
Use warnings to inform users that failure to take or avoid a specified action could result in physical harm to the user or the hardware.

Put all information under one warning. Do not stack warnings. 

Be sure to follow the word Warning with a colon, and put the word and the colon in bold. 

Example:
Warning: Do not use your computer during an electrical storm.


	 
	Web content 
(See also abbreviations and acronyms; bold type; contractions; cross-references; exclamation marks; italic type; typographic conventions)

Editorial standards differ between print publications and Web content. Industry standards for Web content are still evolving. For OU course materials published on the Web, use the following general editorial guidelines: 

Use bold for emphasis rather than italic.

Acronyms may be defined more than once in a single course at the discretion of the editor and CD. (There is not an assumption of linear progression through the course.) 

In cross-references, refer to specific modules, topics, and courses. Do not use next or previous. 

Contractions may be used sparingly. The use of let’s is discouraged. 

Exclamation marks may be used sparingly in quizzes and scenarios. 

Use Arial font for text and Courier New for code and code elements. 

Do not use italic other than in obvious exceptions such as Oracle9i.


	 
	which 
(See that and which) 


	 
	words as words
(See italic type) 


	 
	writing principles

A guiding principle in technical communication is to convey information so that readers can absorb important content and navigate efficiently through your presentation. Follow these general guidelines to develop text that is concise, easy to follow, accessible, and translation-friendly.

Sentence Structure 
Use active voice rather than passive voice. (See also verbs: Active Verbs)

Examples:
You can use Oracle Risk Manager to calculate a variety of risk indicators.
By using Oracle Risk Manager, you can calculate a variety of risk indicators. 
   not
Oracle Risk Manager is used to calculate a variety of risk indicators. 

Structure sentences so that the user, not the software, is in control. (See also allow, enable, let, and help)

Example:
With iSQL*Plus, you can create scripts to store frequently used SQL statements.
   not
iSQL*Plus allows you to create scripts to store frequently used SQL statements.

Address the reader in the second person you, not the third person he or she, and not as the student. Do not use we. 

Examples:
At the end of this lesson, you will complete a guided practice.
   not
At the end of this lesson, we will complete a guided practice. 
   not
At the end of this lesson, students will complete a guided practice. 

Use present tense when describing ongoing actions or things that occur as the result of user action. (See also verbs: Tense)

Examples:
When you click the link, a Web page opens.
   not
When you click the link, a Web page will open. 

Develop sentences so that they are specific, definite, and concrete, eliminating unnecessary words.

Example:
When you use templates and catalogs, you can concentrate on writing documentation, rather than formatting it.
   not
Using templates and catalogs helps you to minimize your formatting time, so that you can spend the majority of your production time writing rather than formatting.

Keep syntax and sentence structure simple. Avoid convoluted sentence structure.

Examples:
If you plan your implementation carefully, problems are less likely to occur.
You use these components to edit code and manage the user interface.
   not
The more carefully you plan your implementation, the less likely problems will occur.
These components are what you use for editing code and for managing the user interface.

Place if and when clauses at the beginning of the sentence, not at the end. 

Examples:
When you select this check box, you can create a purchase order for the supplier.
If your project goes over budget, get approval for additional funds promptly.
   not
You can create a purchase order for the supplier when you select this check box.
Get approval for additional funds promptly if your project goes over budget.

Include the relative pronoun that to aid readability and translation.

Example:
This is the statement that was used to create the revenue table.
Select the menu that you want to move.
   not
This is the statement used to create the revenue table.
Select the menu you want to move.

Include articles (a, an, the) in lists and slides. Omitting articles and other words makes your sentences difficult to follow and presents problems for translation.

Example:
Select Immediate from the LOV in the Payment Terms field.
   not
Select Immediate from LOV in Payment Terms.

Make parts of a sentence that are parallel in meaning parallel in structure. Faulty parallelism is distracting.

Example:
The duties assigned to the administrators were installing new systems and troubleshooting problems.
   not
The duties assigned to the administrators were the installation of new systems and troubleshooting problems.

Do not overuse emphasis in text. If you provide coherent delivery, the reader will follow the sense of the presentation, making emphasis unnecessary.

Example:
Do not select books from the list of media; select them from the alternative list.
   not
Do not (or NOT or not) select books from the list of media; select them from the alternative list.

Note: If you must emphasize a word or phrase in text, use italic in print publications. For online content, use bold. If you need to emphasize a section of text, consider presenting the information as a separate block of text, perhaps with a label preceding it, such as Note or Caution.

Do not use long noun strings or long modifiers. 

Example:
This equipment terminates a data circuit.
   not
This is data circuit terminating–equipment.

Paragraph Structure
A paragraph is one or more sentences about a limited topic. Use the following guidelines to write effective paragraphs.

Use clear headings, a visual tool that makes scanning text easier. Headings that succinctly summarize information within a section provide quick access to material that a reader needs.

Do not place bullets before paragraphs to make them stand out. Use bullets to develop lists. (See also lists)

Confine each paragraph to a single idea.

Do not use single-sentence paragraphs except when they are needed for transitions. Transitions provide continuity from one thought to another, one paragraph to another, or one topic to another.

Begin each paragraph with a sentence that introduces the topic of the paragraph (a topic sentence) or one that serves as a transition from the previous information.

Divide long paragraphs up into shorter ones, even if they continue a line of thought, for visual relief. An effective paragraph in instructional material can contain from one to seven sentences.

Terminology
Use consistent terminology. The terms click, click on, hit, and use the mouse to select all mean the same thing. Check the style guide for the preferred choice, and if it is not listed, decide on one style and use it consistently. (See GUI conventions; typographic conventions)

Except for technical terms that are necessary to your discourse, use familiar vocabulary. Use explain rather than elucidate; begin rather than commence; before rather than prior to; use rather than utilize or employ. 

Do not use terms from database processes in general text. 

Example:
Set the parameter to Auto or Manual at the system level to enable or disable the automatic tuning mode.
   not
Set the parameter to Auto or Manual at the system level to enable or disable the auto tuning mode.

Omit extraneous words that do not contribute to the central thought.

Examples:
Select blue from your color palette. 
Enter your username and password to log in to the database.    
   not
Select the color blue from your color palette. 
Simply enter your username and password to log in to the database. 

Include category names when referring to database processes, GUI elements, and Oracle products.

Example:
RMAN uses the latest backups when performing a RESTORE … UNTIL TIME command.
   not
RMAN uses the latest backups when performing a RESTORE … UNTIL TIME.

Avoid jargon, idioms, and humor. However familiar they sound, they may not be universally understood. (See jargon; translation, writing for)


